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Picarro G2910/G2920 User Manual 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product 

that has been designed and manufactured to provide reliable performance. 

This User Manual (UM) is an important part of your purchase as it will help familiarize 

you with the system and explain the numerous features that have been designed 

into it. Please read this manual thoroughly before using your Picarro system. 

Please contact Picarro or your authorized Picarro distributor should you have questions 

regarding specific applications or if you require additional information. 

NOTICES 

DISCLAIMER AND RESERVATION OF RIGHTS 

Picarro has prepared this manual solely for the information and use by its customers as 

a guide for the selection, installation, operation, and maintenance of the products 

described. 

EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO 

PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO 

DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE 

OF PICARRO PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

Picarro reserves the right to change or update the contents of this manual and the 

specifications of its products at any time, without notice. Picarro has endeavored to 

include information that is current and accurate as of the date of the publication or 

revision of this document, but Picarro does not guarantee that this document is error free 

or that it is accurate with regard to any particular specification. 

Picarro expressly reserves all intellectual property rights, including all intellectual 

property rights relating to any product described in this manual. This document does not 

grant any license, express or implied, by estoppel or otherwise, to any intellectual 

property rights of Picarro or any third party. 

PATENTS 

The products described in this manual are subject to Picarro patents and patents 

pending. Information about Picarro patents applicable to these products is available at 

www.picarro.com/company/patents 

TRADEMARKS 

Picarro and the Picarro logo are trademarks of Picarro, Inc. 

Windows® is a trademark of Microsoft Corporation 

Swagelok® is a trademark of Swagelok Company 

Copyright © 2020 Picarro, Inc. All rights reserved. 

https://www.picarro.com/company/patents
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Picarro G2910/G2920 User Manual 

FCC WARNING 

This equipment has been tested and found to comply with the limits of a Class A 

digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 

provide reasonable protection against harmful interference when the equipment 

is operated in a commercial environment. This equipment generates, uses, and 

can radiate radio frequency energy and, if not installed and used in accordance 

with the instruction manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to 

cause harmful interference in which case the user will be required to correct the 

interference at his own expense.  

CE MARK WARNING 

This is a Class A product. In a domestic environment, this product may cause 

radio interference, in which case the user may be required to take adequate 

measures. 

CANADA ICES WARNING 

This product complies with CAN ICES-3 (A)/NMB-3(A) 
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Contact Information 

Please contact Picarro for questions regarding specific applications and additional information. 

General Technical Support: 

Email:        support@picarro.com  

Phone:       + 1 408 962 3991 

 

European Technical Support: 

Email:        support@picarro.com 

Phone:       +31 85 888 1650 

 

Customer Service: 

Email:        orders@picarro.com 

Phone:       + 1 408 962 3992 

 

Copyright © 2020 Picarro, Inc. All rights reserved. 
3105 Patrick Henry Drive 

Santa Clara, California, 95054 USA 
Phone +1 408 962 3900 • Fax +1 408 962 3200 

www.picarro.com  

mailto:support@picarro.com
mailto:support@picarro.com
mailto:orders@picarro.com
https://www.picarro.com/
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1. Introduction 
The G2910 and G2920 analyzers are designed to measure concentrations of 

ethylene oxide (EtO) gas. The G2910 has been configured for measurements 

near the source of emission and can accommodate a broad measurement range 

of EtO in a complex air matrix. The G2920 has been configured for improved 

sensitivity and can accommodate measurements of EtO further away from the 

source of emission (e.g. at the fenceline). A such, the specifications for the 

G2910 and G2920 are different. However, the setup, method of use, and data 

logging are virtually identical.   

This manual is written for operators, service technicians and maintenance 

technicians who install, operate, and maintain the G2910 or G2920 analyzer. 

For calibration, repairs, or service other than user maintenance detailed in this 

manual, contact Picarro Service Engineering or your local Picarro-authorized and 

certified technicians. 

 

NOTE 

It is not possible to transition from a G2910 analyzer to a G2920, and vice 

versa. The final configuration is performed during production. 

1.1 Intended Use 

The G2910/G2920 Ethylene Oxide Analyzer measures concentrations of 

ethylene oxide (C2H4O) gas using Picarro’s patented Cavity Ring-Down 

Spectroscopy (CRDS). Picarro’s CRDS enables state of the art lower limits 

of detection, exceptionally low drift, all in an easy to use and deploy 

system. It is an ideal tool for background, near-source and source 

monitoring of EtO from a variety of emission sources.   

Zero drift corrections using ultra-high purity gases or cartridges are not 

required to meet instrument specifications. Additionally, carbon dioxide 

(CO2), methane (CH4), and water vapor (H2O) can be measured.  

This analyzer can be deployed in a lab or in the field, allowing in-situ 

analysis for trace EtO or ambient EtO monitoring applications. 
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1.2 External Vacuum Pump 

The external vacuum pump (Figure 1) is used to maintain cavity pressure 

inside the analyzer. The pump should be connected and running whenever 

the analyzer is in use. 

      

Figure 1: Vacuum Pump – Side Views 

1.3 Analyzer Specifications 

Table 1: G2910/G2920 Operating Specifications 

Parameter Specification 

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS) 

Measurement Cell 
Temperature and 
Pressure Control 

±0.005 °C (±.009 °F); ±0.0002 atm. (±0.0203 kPa) 

G2910 Sample 
Temperature 

–10 °C to 80 °C (14 °F to 176 °F) 

G2920 Sample 
Temperature 

–10 °C to 80 °C (14 °F to 113 °F) 

G2910 Sample Flow 
Rate and Pressure 

~ 200 sccm at 760 Torr (101.4 kPa),  
300 to 1000 Torr (40 to 133 kPa) 

G2920 Sample Flow 
Rate and Pressure 

~ 200 sccm at 760 Torr (101.4 kPa),  
600 to 1000 Torr (40 to 133 kPa) 

Sample Humidity < 99% RH non-condensing at 40 °C (104 °F), no drying 
required 

Ambient Temperature 
Range 

Operating: 10 °C to 35 °C (50 °F to 95 °F)  
Storage: –10 °C to 50 °C (14 °F to 122 °F) 

Ambient Humidity < 85% RH non-condensing 
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Parameter Specification 

Maximum Altitude  
(During operation) 

3,048 m (10,000 ft.) 

Clearance Front: 15.3 cm (6”); Rear: 15.3 cm (6”) 

Primary Gas Measured C2H4O Ethylene Oxide (EtO)  

Other Gases Measured CO2, CH4 and H2O 

Accessories Included: Pump (external), keyboard, mouse 
Required: LCD monitor (Supplied by Customer) 
Optional: A0311 or A0311-S 16-port Distribution 
Manifold 

Operating System and  
Data Outputs 

Windows 10  
RS–232, Ethernet, USB, Data Streaming;  
Optional Analog 0–10 VDC 

Fittings 6.35 mm (¼”) Swagelok SST fittings 

Dimensions Analyzer: 43.2 cm W x 17.9 H x 44.6 D (17” x 7” x 17.5”) 
not including analyzer feet 12.7 mm height (0.5”) 
External Pump: (19 x 10.2 x 28 cm) (7.5” x 4” x 11”)  

Installation Benchtop or 48.3 cm (19”) rack mount chassis 

Weight Analyzer: 21.3 kg (47.0 lbs) 
External Pump: 6.5 kg (14.3 lbs) 

Power Requirements 100 – 240 VAC; 47 – 63 Hz (auto-sensing) 

< 375 W (at start-up – total) 

120 W (steady-state operation: analyzer) 

150 W (pump) 

Liquid Ingress Protection None 



Conventions   

G2910/G2920 UM P/N 40-0076 Rev. A 15 

2. Conventions 
The following icons are used throughout this manual to emphasize important 

information in the text. These icons indicate dangers to either the operator or to 

the analyzer, and other important information. 

Table 2: Warning/Information Icons 

Icon Description 

 

Consult the user manual for important information (When you see this 
symbol placed at hazard points on equipment, consult the user manual). 

 
NOTE 

NOTE is important information that you should be aware of before 
proceeding. 

 

WARNING 

LASER WARNING alerts you of a laser danger. 

 

CAUTION 

CAUTION alerts user of a potential danger to equipment or to the user. 

 

WARNING 

WARNING indicates an imminent danger to the user. 

 
WARNING 

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to 
electrical energy that is high enough to cause injury or death. 

 

CAUTION 

HOT SURFACE alerts user to potential injury from hot surfaces. 

 

REMINDER 

REMINDER is a helpful hint for procedures listed in the text. 
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3. Safety 

3.1 General Safety 

The Picarro G2910/G2920 complies with the following safety standards: 

• CE: IEC EN61010-1:2010 (safety) and EN61326-1:2013 (EMC) 

requirements for electrical equipment for measurement, control, and 

laboratory use. 

• FDA/CDRH 21: CFR Parts 1040.10-11 

 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in 

damage to the analyzer and render it unsafe to operate. 

 

 
WARNING 

The analyzer is not waterproof and proper measures should be taken to 

protect from exposure to liquid water 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the 

presence of flammable gases or fumes.  

 

 
CAUTION 

The analyzer contains no user serviceable components except the 

particulate filter, fans, and the vacuum pump. Do not attempt repairs; 

instead, report all problems to Picarro Customer Service or your local 

distributor. Please contact Picarro if you have any questions regarding 

the safe operation of this equipment. 

 

 
CAUTION 

Do not replace the mains supply power cord with an inadequately rated 

cord. 

 

 
CAUTION 

HOT SURFACE: The inlet gas connector on the back panel of the Analyzer, 

and its immediate vicinity, runs hot during operation of the analyzer. Take care 

when connecting gas lines or working at the rear of the instrument to wear 

protective gloves or avoid contact with these surfaces. 
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WARNING 

This analyzer weighs 47 lbs (17.5 kg) Use the technique described below (or 

follow your local regulations) when lifting the analyzer. 

a. Before lifting, inspect the unit for slippery substances or sharp edges. 
b. Lift with two people, one on each side of the analyzer. 
c. Crouch down and stay close to the unit. Always keep your back as 

straight as possible.  
d. Position your feet for sturdy balance. Lift with your legs, not your 

back.  
e. Do not twist the back while carrying the unit. Rotate direction with hip 

joints.  
f. Lower the unit by bending at the knees.  

3.2 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an embedded 3B 

laser in accordance with EN 60825-1:2014. Do not to open the enclosure where 

this label is placed; there are no user serviceable parts inside. 

The following Laser Safety Label is affixed to the outer cover of the 

analyzer. 

 

Figure 2: Laser Safety Label – Affixed to Outside Cover of Analyzer 

 

 
WARNING 

The laser is a Class 3B when exposed.  

Only operate or service this device in accordance with the instructions in this 

guide, and only open the device in an approved laser safe service area using 

appropriate laser-safety glasses. 

The following Laser Safety Label is affixed to the inside of the analyzer: 

 

Figure 3: Laser Safety Label – Affixed to Inside of Analyzer 
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CAUTION 

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure. 
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4. Acronyms 
This manual includes various acronyms. For definitions, see below:  

Table 3: Acronyms, Formulas, Units, and Symbols 

Acronym Definition 

atm. 
atmosphere; unit of pressure, approximately equal to atmospheric pressure at 
sea level. 1 atm. = 14.69595 psi (101.325 kPa)  

C2H4O Ethylene Oxide 

CH4 Methane 

cm centimeters  

CO2 Carbon Dioxide 

CRDS Cavity Ring-Down Spectroscopy  

DAS Data Acquisition System (the Analyzer) 

EtO Ethylene Oxide 

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm) 

GUI Graphical User Interface  

H2O Water, Water Vapor 

HB Hotbox  

kPa Kilopascal; unit of pressure; 1 kPa = 0.145 PSI 

mm millimeters  

OD Outside Diameter 

ppb parts per billion  

ppm parts per million  

ppt parts per trillion 

PSI (psi) Pounds per Square Inch 

RH Relative Humidity 

sccm standard cubic centimeters per minute 

SST Stainless Steel 

UM User Manual 

WB Warm box  

WLM Wavelength Monitor 

“ (as in 1/4”) Inches 

°C degrees Celsius  

‰ per mil 
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5. Unpacking Analyzer Components 

5.1 Inspect the Shipping Boxes 

Picarro products are inspected and tested before leaving the factory. Their 

packing containers have been designed to keep the equipment safe from 

damage during transit. 

Inspect the condition of the boxes upon arrival. The larger box includes the 

analyzer and most of the accessories. Even if the outer box shows 

damage, the inner box holding the analyzer will protect the instrument 

under most circumstances. 

If the equipment does appear to be damaged, photograph the damages 

and contact Picarro (email pictures if possible) as soon as possible. 

5.2 Unpack the Shipping Boxes 

This section describes the contents of the shipping boxes: 

• Inspect each item to ensure it is not damaged.  

• If items are missing, contact Picarro. 

• Keep the shipping packages to reuse when transporting the 

analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 

 
WARNING 

This analyzer weighs 47 lbs (17.5 kg). Use the technique outlined in the 

General Safety section on Page 17 when lifting or moving the analyzer.  
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Figure 4: G2910/G2920 Box Contents 

 

Table 4: Box One: Analyzer and Accessories 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 
communications hardware and firmware to perform 
all gas handling, spectral collection, and analysis. 

AC Power Cables (1) A power cable with connectors appropriate to your 
country is provided. The analyzer automatically 
adjusts to local voltage. 

Keyboard (1) USB keyboard. 

Mouse (1) USB mouse. 

Control Cable (1) For External Solenoid Valves. 

Nut (1) and Ferrules (2) For connecting input line to analyzer INPUT. 

Document Packet (1)  Includes this manual, certificate of compliance, and 
Windows License. 

USB Flash Drive  Contains backup software. 

  

USB 
Backup 
Software 

Windows License 
G2910/G2920 
User Manual 

Analyzer 

Pump to 
Analyzer 
Vacuum 

Hose 

Vacuum Pump 

Control Cable 
for External 
Solenoid 
Valves 

Connectors 
for Control 
Cable 
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Table 5: Box Two: Vacuum Pump and Accessories 

Item (qty) Description 

Vacuum Pump (1) Provides vacuum required for sample gas sequencing into 
and out of the analyzer. 

AC Power Cable (1) A power cable with connectors appropriate to your country 
is provided. The pump automatically adjusts to local 
voltage. 

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

Pump Manual (1) Detailed instructions for pump. 
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6. Installation 
This section describes the setup and installation of the Picarro Analyzer. Please 

read and understand this section thoroughly before proceeding with the 

installation. 

 
WARNING 

Equipment Damage: Do not attach electrical power to or start the 

analyzer until after attaching and turning on the External Vacuum Pump. 

Do not disconnect the vacuum line while the analyzer is running. Failure 

to do so could result in damage to the optics. 

 

 
WARNING 

Picarro sells USB enabled devices, such as GPS, which is approved for 

use. Please do not connect USB hubs or unapproved USB devices, other 

than flash drives to the computer because they can interfere with the 

operation of the analyzer. 

 

 
WARNING 

If rack mounted, the Analyzer cannot support itself using a front rack 

mount kit alone. The instrument must be supported by a shelf or 

additional rails attached to the rack. 

 

 
CAUTION 

If the analyzer has been stored at less than 10 °C, allow the components to 
equalize to room temperature before starting the installation process. 

 

 

NOTE 

Take care to ensure that warm air can be exhausted from an enclosure in 

which the analyzer is mounted. 

 

 
CAUTION 

Equipment Damage: It is imperative that the analyzer have adequate 
ventilation and/or cooling to maintain the ambient temperature below 35 °C 
when operating. Failure to provide adequate airflow, especially clearance at the 
front and rear panels, to ensure proper airflow and/or cooling to the analyzer will 
result in overheating of the analyzer causing a shutdown and potential damage. 
There should be 4” (10 cm) of clearance in the front and back of the analyzer. 

Thermal Specifications Min Max Description 

Ambient Operating 
Temperature 

10 °C 35 °C Worst-case environmental limits 
(unless otherwise specified) 
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6.1 Analyzer and Vacuum Setup 

1. Remove the Analyzer and the External Vacuum Pump from their 

respective shipping containers. 

2. Place the Analyzer on a bench top or flat surface. Place the 

External Vacuum Pump nearby or on the floor. Don’t push the 

analyzer into position yet; there are cables to be installed on the 

back panel. 

3. Unpack the analyzer accessories. The Certificate of Compliance 

and USB drive should be stored in a safe place and may be 

required if you contact Picarro with questions about your analyzer. 

4. Remove the caps from the analyzer’s INLET and VACUUM 

connection ports (Figure 5). Save the caps; you should reinstall 

them when the analyzer is stored, moved or shipped. 

 

1. External Vacuum Port to Vacuum Pump 

2. Gas Inlet 

3. USB Ports (4 ea) 

4. HDMI Port 

5. COM 2 Port  

6. COM 1 Port 

7. DVI-D Video Monitor Port 

8. DVI-I Video Monitor Port 

9. USB Ports (2 ea) 

10.  Ethernet Ports – RJ-45 (2 ea) 

11.  Audio In/Out Ports 

12.  AC Power Input and Switch 

13.  Valve Control Port (Solenoid valves) 

14.  DIO (not used with this analyzer) 

15.  COM 3 Port (Rotary valve – A0311, A0311-S) 

16.  Not used 

Figure 5: EtO Analyzer Back Panel 

1 

2 
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11 12                       
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5. Set the vacuum pump input voltage to the correct level for your 

area by rotating the voltage selector switch located on the side of 

the pump next to the fuse holder (shown in Figure 6 below). 

6. Remove the cap from pump vacuum inlet. Save the cap for later 

use. Reinstall the caps whenever the pump is stored, moved or 

shipped.  

 

Figure 6: Pump Voltage Selection 

7. Connect one end of the vacuum hose to the pump: hand tighten 

the nut and then use an 11/16” wrench (not included) to make an 

additional turn of one flat (about 60 degrees).  

8. Connect the analyzer to a power source using the supplied AC 

power cable.  

9. If desired, attach a tube to the External Vacuum Pump exhaust 

port and direct to a safe place for venting the mixture of sample 

gases. 

10. Connect the External Vacuum Pump to a power source using the 

other AC power cable. 

 

NOTE 

The software to operate the instrument will start automatically after the 
operating system has loaded. The user interface will appear a few seconds 
after the instrument software starts. See “Startup Procedure“ in Section 7.1. 

Vacuum Inlet Power Connector 
and Switch 

Exhaust Port 

Input Voltage Selector 

Fuse 
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6.2 Connecting to the Analyzer Inlet 

Connect to the inlet of the analyzer using ¼” OD stainless steel (SST) 

tubing using the supplied SST ¼” inlet nut and ferrules. 

 
WARNING 

When using compressed gases, follow all appropriate safety conventions, 

including use of eye protection, physical restraint of cylinders, etc. 

Making a New Connection: 

When using new tubing, follow these steps. 

1. Place the two ferrules inside the nut as shown in Figure 7 below. 

2. Loosely connect the nut to the INLET on the back panel of the 

analyzer about a full turn, being careful not to let the ferrules fall 

out. 

 

Figure 7: Orientation of Ferrules and Nut 

3. Loosely connect the nut to the INLET on the back panel of the 

analyzer about a full turn, being careful not to let the ferrules fall 

out. 

4. Insert the tubing into the back of the nut, feeding it in as far as 

possible without deforming the tubing. 

5. Hand tighten the nut. 

6. Using a 5/8” wrench (not included), tighten the nut approximately 

seven flats (420 degrees). 

Replacing a Connection  

When reattaching tubing that already has a nut connected: 

1. Inspect ferrules. If you see any damage, replace the ferrules and 

follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer’s 

INLET. 

3. Using a 5/8” wrench (not included), tighten the nut approximately 

one flat (60 degrees).  
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6.3 Setting Up Monitor, Keyboard, and Mouse 

A video monitor (not included), keyboard, and mouse are required for 

monitoring device operations, viewing, or changing settings (including 

setting user permissions), or validating device performance. 

 

NOTE 

This device will operate under its default settings without any direct control of 
the internal software. 

1. Connect a keyboard to one of the available USB ports. 

2. Connect a mouse to one of the available USB ports. 

3. Connect a monitor to one of the monitor ports. The analyzer will 

detect the connection and adjust the resolution to match the 

monitor. 

4. Connect the monitor to a power source. 

5. Turn on power to the monitor. 
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7. Analyzer Basic Operation 

7.1 Startup Procedure  

This section describes the steps to power on the system. These steps are 

sufficient for operating the instrument. 

 
CAUTION 

Always turn on the external pump before turning on the analyzer. 

1. Switch on the external vacuum pump.  

2. Switch on the main power to the analyzer on the rear panel.  

3. Press the soft power button located on the front panel. The 

software will start automatically and the analyzer will display the 

CRDS Data Viewer window. Data Viewer features are detailed in 

Section 8.  

4. Wait approximately 45 minutes for the system to power, initialize, 

and stabilize. 

5. Once the cavity pressure and operating temperature are at their 

proper setpoints and stable, the analyzer will start measuring. 

 

NOTE 

As the instrument is starting up, it is normal for there to be a delay in reporting 
data. This can take several minutes depending on how long it takes for the 
internal temperature and pressure to reach their operating points, and it is 
normal during this time for some concentration readings to be negative or 
constant.  

The data selection pull-down menus will not be populated with the appropriate 
items until actual data is being reported in the graph. This is typically less than 
30 minutes, but depending on ambient temperature, the analyzer can take up 
to 1 hour to stabilize. 

 

 

NOTE 

The GUI heading title may vary depending on the analyzer type. 
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Figure 8: Picarro Analyzer GUI 

7.2 Desktop Icons and Folders 

On the Windows desktop, there will be the following icons and folders: 

1. Start Instrument: When clicked, the analyzer will start measuring 

in the configuration that it was in when the software/analyzer was 

shut down. 

2. Coordinator Launcher: Depending on the system’s configuration, 

the coordinator program may not be included. Clicking on this icon 

will lead you to a window that will allow you to choose the proper 

coordinator to operate the peripheral module that came with your 

analyzer.   

3. Picarro Mode Switcher: When clicked, you will be led to a 

window that will allow you to switch between various measurement 

modes. Most analyzer models are configured for one mode and 

may not include the Mode Switcher. If the analyzer has multiple 

modes, this allows the user to switch between them easily. 

4. Picarro Controller: When clicked, you will be led to a useful 

diagnostic panel allowing the user to see the analyzer’s internal 

temperatures, pressure, and spectroscopy in real time. This 

program has user-accessible functions, but it cannot change 
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anything related to analyzer functionality. It is intended for 

diagnostic purposes only. 

5. Picarro Utilities Folders:  

a. Data file Viewer: When clicked, you will be led to a window 

that will allow you to convert between *.dat and H5 data files 

and to make various graphical representations of your data. 

The instructions on using the Data File Viewer software are 

described in the Appendix B  

b. Data Recal: When clicked, you will be led to a window that 

will allow you to recalibrate your data based on known, 

certified data. 

c. Setup Tools: When clicked, you will be led to a window that 

will allow you to edit various settings for your analyzer (See 

the Setup Tool in Section 9.5 of this manual for information 

about these settings). 

6. Diagnostic Folder 

a. Stop Instrument: When clicked, you will be led to a window 

that will allow you to turn off the analyzer in an emergency 

event. Upon clicking on this icon, the following window will 

pop up. Please see Shutdown Procedure on page 31 to shut 

down the analyzer under normal circumstances. 

 

Figure 9: Stop CRDS Software Pop-up 

 

 
CAUTION 

Equipment Damage: EXCEEDING GAS INLET PRESSURE OR TEMPERATURE 
SPECIFICATIONS COULD RESULT IN DAMAGE TO THE INSTRUMENT. In the 
case of higher input pressure or flow, configuring a sampling bypass manifold 
system is recommended. 

Use a ‘tee’ at the gas inlet and either return the remainder to the main gas stream 
or exhaust appropriately. 
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CAUTION 

Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum 
line or the AC power to the External Vacuum Pump while analyzer is operating. 
Damage may be caused by current surges if power is applied while attaching or 
removing cables. 

7.3 Shutdown Procedure 

To shut down the analyzer using the GUI: 

1. Click on the “Shutdown” button located on the left side of the Data 

Viewer window.   

2. A window will pop-up (Figure 10) prompting the user to confirm the 

shutdown. Once confirmed, the analyzer software and hardware 

will turn off.  

3. Manually turn off the pump(s) and dry gas (only if your system 

requires it). 

 

CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 

for several minutes prior to shutting down. Trapping a high-moisture content 

gas sample in the cavity can cause condensation damage to the mirrors as the 

instrument cools from its operating temperature. 

 

 
CAUTION 

Do not turn off the pump or disconnect the vacuum line while the instrument is 

operating. 

 

CAUTION 

FOR G2xxx ANALYZERS: If you have trouble turning off the analyzer software, 

do not kill the process(es) in the task manager; rather, double-click on the “Stop 

Instrument” icon in the Diagnostics folder on your desktop. 
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Figure 10: Shutdown Confirmation Pop-up 

7.4 In Case of Electrical Power Outage 

If the power to the analyzer is cut-off for any reason, the analyzer will 

cease operation. However, when the power is reapplied, the analyzer will 

restart automatically. The Picarro software tools will also properly close out 

previous files and open new files for data collection so that previously 

collected data, instrument diagnostics, and other parameters recorded up 

to the time of power outage are retained. 

If short power outages will be a routine occurrence in your operating 

environment, Picarro recommends the use of an uninterrupted power 

supply (UPS) to prevent damaging the hardware or software.  
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8. List of GUI Functions 

8.1 GUI Overview 

The features of the Picarro analyzer GUI are identified in Figure 11 and 

described in the following sections.  

 

1. Settings, View, Tools, and Help menus 

2. Alarm Panel 

3. Digital Readouts 

4. Data Log, Filename, and Path 

5. Status Log Window 

6. Data Source, Data Key, and Precision pull-
down menus for data window content 

7. Axis Auto Scaling 

8. Reset Data Buffer 

9. Data Buffer Level Meter 

10. Data Windows 

Figure 11: Layout of G2910/G2920 Analyzer GUI 
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8.2 Settings, Tools, and Help Menus 

Settings Menu  

Left clicking on the Settings menu pulls down a menu that has one entry 

‘Change GUI Mode from Standard to Service.’ This is the access point to a 

password protected service mode where additional operational and 

measurement parameters are displayed. Selecting and clicking on this 

entry opens the Cavity Ring-Down Spectrometer Controller. This is 

reserved for Picarro service operators only. 

View Menu 

This menu item has three entries: 

1. Lock/Unlock time axis when zoomed: When locked, forces the two 

graphs to display the same time scale during zoom. 

2. Show/hide statistics: Toggles the measurement statistics display, 

see Digital Readouts section on Page 39 below. 

3. Show/hide instrument status: Toggles the status of the instrument 

display.  

4. Instrument Status below. 

Tools Menu 

This menu item has three entries: 

1. User Calibration: Opens the user calibration window (default 

password is “picarro”). The password can be reset in the 

QuickGui.ini file in the instrument directory: 

“C:\Picarro\G2000\AppConfig \Config\QuickGUI\” under the 

section:  

[Authorization] UserCalPassword = Picarro Show/Hide Valve 

2. Sequencer GUI: Toggles the display of the external valve 

sequencer window. 

3. The calibration slope and intercept can be entered and their effects 

immediately were seen in the data. Please refer to the Calibration 

section on Page 55. 

Help Menu 

1. About: Displays the version number of the instrument. 
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8.3 Alarm Panel 

This panel is used to monitor the status of the internal instrument alarms. 

These indicators are gas concentration alarms, such as “C2H4O Too 

High/Low” depending on instrument configuration. The gas concentration 

alarm LEDs are off (grayed) when the respective concentrations are below 

a certain value, and they are illuminated when the respective 

concentrations are above/below a certain value. To view the alarm set 

point, click on the LED and a dialog box (Figure 12) will appear indicating 

the alarm setting and allow the user to enable it or change the setpoint: 

 

Figure 12: Alarm Setting Window 

Type the value you wish to set the alarm to and press the “OK” button, or 

press “Cancel” if you do not wish to change the alarm value. If you do 

nothing, the dialog box will disappear, and the alarm value will remain 

unchanged. 

  



    List of GUI Functions 

36 P/N 40-0076 Rev. A G2910/G2920 UM 

8.4 Instrument status 

If these parameters are enabled through the ‘Show Instrument Status’ 

entry in the ‘View’ Menu on the main toolbar digital readouts for Warm Box 

temperature, Cavity Temperature and Cavity Pressure are displayed to the 

left of the main trend graphs. 

 

Figure 13: Instrument Status 

8.5 Data Log Filename and Path 

The filename and path of the active data log are displayed in this pan. The 

indicator is grayed-out if there is no active data log (i.e., if a new data log 

has not been started using the Start /Stop New Data Log Button). A new 

file will be generated at midnight, which will be saved to the same location 

as the original log file. 

 

Figure 14: Data Log Filename 

8.6 Data Window 

The data window (Figure 15) displays a graph of any stream of data vs. 

system time, with a format of hh:mm:ss. The user can select which data 

stream is displayed using combinations from the Data Source and Data 

Key pull-down menus. The precision displayed can be adjusted using the 

“Precision” menu and Auto-scaling of the ‘Y’ axis is also available. 
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Figure 15: Data Window 

Data Source and Data Key Pull Down Menus 

These two menus enable selection of the data stream that is viewed in the 

data window. Data streams available on the GUI are gas concentrations, if 

‘instrument Analysis’ (where instrument represents the system installed) is 

selected, or if “sensors” is selected, the analyzer’s optical cavity pressure 

or temperature can be viewed as well as the nominal ambient temperature 

of the analyzer (“DAS temp”) and the temperature of the analyzer’s 

electronics chamber, indicated as “warm chamber temp.” 

 

Figure 16: Data Source  

Precision Pulldown Menu 

Click on this icon (Figure 17) to select the precision displayed on the y-

axis, between 0 and 4 digits of precision or “auto.” The currently selected 

precision is displayed during operation. This does not affect the precision 

of the saved data in the data log files or results files. 
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Figure 17: Precision Pulldown 

Data Buffer Level Meter 

The meter to the right of the Data Window indicates how much of the 

internal memory of the GUI is used to retain historical data collected with 

the instrument. There is an internal limit of a finite number of points. Once 

that number of data points is collected, the buffer is full, and old data is 

removed from the buffer as new data is collected. This buffer affects only 

the data displayed in the data window, not the data stored in any files. This 

buffer is empty upon instrument startup and can also be emptied by 

pressing the reset data buffer button in the lower-right-hand corner of the 

GUI. 

 

Figure 18: Data Buffer and Reset Buffer 

Reset Data Buffer Button 

Press this button to clear the internal data buffer of the GUI (this clears the 

current data traces from the graphs). This has the effect of clearing all data 

in the data window. Pressing this button has no effect on any of the data 

log files stored by the instrument. 
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Graph Zooming 

To zoom the graph, simply drag the magnifying glass over the section to be 

zoomed and click/hold the left mouse button. While holding down the left 

button, move the mouse to create a box that covers the region of interest. 

When the box is properly drawn, release the left button and boxed area will 

automatically scale to fill the data window. To zoom back out, double-click 

on the left button. To auto scale, the y-axis of either graph, use the auto-

scale buttons below the graph. To lock or unlock the time axis of each 

graph during zooming, select that menu item in the ‘View’ menu. 

 

Figure 19: Graph Zooming 

Digital Readouts 

Displays the latest value recorded for the selected Data Key for each Data 

Window. Changing the Data Key modifies the Digital Readout as well as 

the Data Window view. If the ‘Show Statistics’ entry is enabled in the ‘View’ 

menu, the mean, standard deviation and slope of the data in the graph are 

dynamically calculated and indicated below the digital concentration 

readout. These numbers change to reflect statistics of whatever data is in 

the data window. 

 

Figure 20: Digital Readouts 



    List of GUI Functions 

40 P/N 40-0076 Rev. A G2910/G2920 UM 

Start / Stop Data Log Button 

The Analyzer automatically records all data collected on the instrument and 

saves it for later analysis. These files are called Data.dat files, which are 

described below in the section called File Management. In addition, the 

user can record a separate data log file. Press this button if you would like 

the instrument to start recording a separate data file. A dialog box will 

appear prompting you for a filename and location. Press this button again 

to stop recording the data file. 

8.7 Status Log Window 

This window displays instrument status messages, in the following form: 

“MM/DD/YYYY hh:mm:ss generic message text.” These messages include 

all messages sent to the DAS front panel display. The common status log 

messages are: 

1. Temperature Locked: WB (HB) 

The system waits for the warm box (“WB” – the temperature-

controlled electronics and wavelength monitor chamber) to reach 

operating temperature. Similarly, the temperature of the hot box 

(“HB” – the temperature-controlled chamber containing the 

analyzer’s optical cavity and gas handling system) is stabilized. This 

is typically the longest step in the startup sequence. The duration of 

this step can range from 5 to 60 minutes, depending on the ambient 

temperature and how much time has elapsed since the last startup. 

2. Entering Measurement  

Spectral scanning has started. Concentration measurements will be 

available in approximately 30 seconds. The instrument will continue 

to scan and report concentration measurements until the instrument 

is shut down using the procedure below. 

3. Pressure Stabilizing/Locked 

The valve control system begins to allow flow through the analyzer 

and stabilizes the pressure inside the cavity. 

4. Measuring  

This is the normal mode of operation after startup has completed. 
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9. File Management 

9.1 Overview  

During operation, the Analyzer generates various ASCII-format text output 

files that are updated after each batch of concentration measurements is 

complete. For example, one of the user output files is named: 

UV1xxx-YYYYMMDD-hhmmssZ-DataLog_User.dat 

Where “UV1xxx” or similar is the instrument serial number and where Z 

denotes “Zulu” or GMT for time zone. The data files are created every 15 

minutes. 

File Name 

The file name is generated from the instrument serial number, the date, 

and the time when the instrument was started. For example: 

UV1123-20200410-093852Z-DataLog_User.dat 

• UV1123 is the instrument serial number 

• 20200410 is the date, 4/10/2020, in format YYYYMMDD (to allow 

chronological sorting of data files). 

• 093852Z is the time the file was started, 09:38.52 am, formatted as 

hh:mm:ss using a 24-hour clock. Z = Zulu time = GMT 

Raw User Data 

The raw user data are contained in folders in the directory: 

C:\UserData\DataLog_User\[year]\[month]\[day]\hour.  

Data File Creation Frequency 

Data files are created every 15 minutes and stored for 90 days before they 

are automatically deleted. The file deletion frequency and details can be 

modified in the file: 

C:\Picarro\G2000\AppConfig\Config\Archiver\Archiver.ini. This is explained 

below. 

Data File Archiving 

During data acquisition, the analyzer creates directories to store the data, 

based on the date the data were acquired. After each data file has been 

closed (every 15 minutes) it is moved to an archive directory, and a new 
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file is started in the original location. The archive directory is 

C:\Picarro\G2000\Log\Archive\ and has subdirectories DataLog_Mailbox, 

DataLog_Private, and DataLog_EventLogs with files arranged by 

year\month\day\hour. 

Additional Data for Diagnostics 

There are complete data files which include additional information beyond 

the concentration data including parameters such as instrument 

temperatures and pressure, set points and spectroscopic information. This 

information is generally not useful to the user but can be useful for 

diagnostic purposes and is stored in the directory: 

C:\Picarro\G2000\Log\Archive\DataLog_Private\[year]\[month]\[day]\[hour]. 

For more information about how to include various columns of data from 

the DataLog_Private in the DataLog_User files in the C:\UserData 

directory, please contact Picarro. 

The current data file can be found in C:\Picarro\G2000\Log\DataLogger\ 

Within this directory, there are subdirectories for DataLog_Private and 

DataLog_User. Similarly, the archive directory has subdirectories arranged 

by file type. The subdirectories are further organized by 

\[year]\[month]\[day]\[hour]. 

Simplified Management 

To keep the data files easy to manage and to limit the size of individual 

files and directories, the software automatically generates new files each 

time the instrument is powered up and at midnight each night. When new 

files are created at midnight GMT, their file name will contain the new date 

and a time of 00:00. For example, if the system were started at 10:29 am 

GMT on 4/10/2020 it would create a file named: 

20200410\UV1123-20200410-102900Z-Datalog_User.dat 

Then at midnight GMT, a new file will be created: 

UV1123-20200410-000000Z-Datalog_User.dat 

  



File Management   

G2910/G2920 UM P/N 40-0076 Rev. A 43 

9.2 File Archival and Automatic Deletion of Old Files 

The analyzer can automatically compress (zip) and archive old files as 

mentioned above. This operation is controlled by the .ini file: 

C:\Picarro\G2000\ AppConfig\Config\Archiver\Archiver.ini. For each 

file type, there are various items along with some recommended default 

settings which may vary by file type: 

• Directory = C:/UserData/DataLog_User 

Optionally specifies which directory to find files to the archive. 

Archiver.ini Settings 

• MaxCount = –1 

Specifies how many files to keep. A setting of –1 indicates that there 

is no maximum number of files. Generally, –1 is used in conjunction 

with a maximum size limit, below. 

• MaxSize_MB = 1500 

Specifies that a maximum of 1.5 GB of data is to be kept before the 

system begins to delete old data. 

• Compress = True/False 

Specifies if archived files are to be zipped – recommended setting is 

true to save hard drive space. True means files are zipped, false 

means files are not zipped. 

• AggregationCount = 0 

If compression is set to TRUE, specifies how many files to be 

included in each zip archive. 

• StorageMode = FIFO 

First in first out. Specifies that old data is deleted first. 

• Quantum = 4 

Generally, should not be changed. Specifies the files be sorted by 

year\month\day\hour in the archived directory structure. 
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Automatic File Deletion 

In addition to the automatic file and directory management described 

above, the analyzer also automatically deletes various files specified in 

C:\Picarro\ G2000\AppConfig\Config\FileEraser\FileEraser.ini. There are 

various settings, as described below: 

• runtime_interval_hrs = 0.5 

Specifies how often (in hours) to run the file eraser. 

• path = ../../../Log/Archive/DataLog_Private 

Specifies which directory to look in for files to delete. 

• extension = data 

Specifies which files having what extension are to be deleted. If 

empty, it deletes all files. 

• delete_time_hrs = 48 

Specifies how long to keep files prior to deletion. 

9.3 Measuring Time in Picarro Data Files 

Since measurements performed by Picarro analyzers are asynchronous 

(they require a variable and unpredictable amount of time to complete), 

data reported by the analyzer is time stamped. Each independent 

measurement is given a time derived from the Windows™ computer 

system clock. This time can be reported by one or many of the following 

variables. 

Table 6: Data Time Stamp Definitions 

Variable Name Definition Units 

DATE The calendar date formatted as YYYY-MM-DD  

Example: April 24, 2020 is formatted as 2020-04-24 

-NA- 

 TIME The time of day formatted as HH:MM:SS.SS on a 24-
hour clock  

Example: 4:18:53.12 PM is formatted as 16:18:53.12 

-NA- 

FRAC_DAYS_SINCE_JAN1 The number of days since midnight January 1 of the 
current year  

Example: at 3:00:00 PM on January 12 the value is 
11.625 

days 

FRAC_HRS_SINCE_JAN1 The number of hours since midnight January 1 of the 
current year  

Example: at 3:00:00 PM on January 12 the value is 
279.0 (=FRAC_DAYS_SINCE_JAN1*24) 

hours 
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Variable Name Definition Units 

JULIAN_DAYS The number of the day of the current year  

Example: at 3:00:00 PM on January 12 the value is 
12.625 (=FRAC_DAYS_SINCE_JAN1+1) 

days 

EPOCH_TIME The number of milliseconds since midnight January 1, 
1970  

Example: at 3:00:00 PM on January 12 the value is 
1421074800000 (= time) 

ms 

timestamp The number of milliseconds since midnight January 1, 1 
if the current Gregorian calendar was extended back to 
that time  

Example: at 3:00:00 PM on January 12 the value is 
63556671600000 

ms 

time The number of milliseconds since midnight January 1, 
1970  

Example: at 3:00:00 PM on January 12 the value is 
1421074800000 (= EPOCH_TIME) 

ms 

ymd The calendar date formatted as YYYYMMDD  

Example: August 24, 2020 is formatted as 20200824 

-NA- 

In Table 6 above, all times are reported in GMT (also known as Zulu time 

and very closely related to UTC). We express these timestamps in GMT to 

avoid complications during Daylight Saving Time or when instruments are 

moved across time zones. The accuracy of the times is of course, only as 

good as the accuracy of the Windows™ clock; see section Remote Data 

Access to learn how to automatically synchronize the computer’s clock to a 

time standard. There are many online calculators that convert Epoch Time 

to local time at any time zone, as well as many functions in commonly used 

data analysis programs that perform the same calculations. 
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9.4 Column Headers 

The following table provides information regarding the column headers 

presented in the UserData output files available on a Picarro analyzer. 

Table 7: Column Header Definitions 

Column Header Definition Units 

DATE Date of measurement  

TIME Time of measurement (instrument time)  

FRAC_DAYS_SINCE_JAN1 Fraction of days since Jan 1 (max = 365)  

FRAC_HRS_SINCE_JAN1 Fraction of hours since Jan 1 (max = 8760)  

JULIAN_DAYS Julian days in since Jan 1 00:00 GMT  

EPOCH_TIME Number of seconds that have elapsed since 
Jan 1, 1970 GMT 

 

ALARM_STATUS Binary system alarm (0 = no alarm;  
1 = alarm) 

 

INST_STATUS Hardware status code: after warm-up, normal 
operation is indicated by code 963; see 
Picarro Analyzer Programming Guide 
Remote Command Interface (P/N 40-0063) 
for details 

 

species Integer code designating the molecule being 
measured 

 

ValveMask Integer code indicating which solenoid valves 
are energized 

 

MPVPosition Integer code for the valve position  

OutletValve Integer controlling the flow through the 
proportional valve 

 

CavityPressure Cavity Pressure Torr 

CavityTemp Cavity Temperature °C 

WarmBoxTemp Temperature of the stabilized enclosure 
containing the WLM 

°C 

EtalonTemp Temperature measured at the wavelength 
monitor (WLM) 

°C 

DasTemp Temperature measured on the data 
acquisition system board 

°C 

EtO Ethylene oxide concentration  ppb 

EtO_30s 30 second window average of EtO 
concentration 

ppb 
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Column Header Definition Units 

EtO_2min 2-minute window average of EtO 
concentration 

ppb 

EtO_5min 5-minute window average of EtO 
concentration 

ppb 

CO2 Carbon dioxide concentration ppm 

CH4 Methane concentration ppm 

H2O Water vapor concentration % 

pzt_offset Digital position of the piezoelectric element  counts 

wlm_offset Frequency offset to align spectra to model 
functions  

cm-1 

9.5 Setup Tool 

In the desktop folder called Picarro Utilities, the Setup Tool can be 

launched by double-clicking on its icon. The tool allows the user to 

configure data file saving details, including which data elements are written 

to data files, digital data output (via serial port or TCP/IP), remote data 

delivery (via email), and general GUI properties. 

Mode 

Located at the bottom of the Setup Tool window, click to select the 

measurement mode (in this case, Ethylene Oxide Analyzer is selected). 

Data Logger 

The Data Logger tab (Figure 21 below) allows the user to configure various 

data file saving details, including which data elements are written to data 

files. 

• Data Columns:  

Controls which data elements are written to data files.  

• Hours of Each Log File:  

Controls the size of each data document.  

• Enable Mailbox Archiving:  

Enables archiving of data in the mailbox folder: 

C:\Picarro\G2000\Log\Archive\DataLog_Mailbox 

• Archived Directory Structure:  
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Specifies part of naming convention for data documents.  

• Total User Log Storage Size (GB):  

Specifies the size of storage allowed for User Data (Recent Data).  

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

 

Figure 21: Setup Tool – Data Logger Tab 

Port Manager 

The Port Manager tab (Figure 22) allows you to control digital data 

output/Input via serial port or TCP/IP. 

• Data Streaming: Specify the port for data streaming 

(COM1/COM2/COM3/Off) 

• Valve Sequencer MPV: Specify the port for connecting to Valve 

Sequencer (COM1/COM2/COM3/Off) 
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• Command Interface: Specify the port for Command Interface 

(COM1/COM2/COM3/TCP/Off).  

• GPS: Specify the port for connecting to GPS 

(COM1/COM2/COM3/Off) 

• Anemometer: Specify the port for connecting to Anemometer 

(COM1/COM2/COM3/Off) 

Make sure there are no COM port conflicts before clicking “Apply.” After 

making the appropriate edits, click “Apply” to put changes into effect and 

then “Exit” to close the window. 

 

Figure 22: Setup Tool – Serial/Socket Port Manager 

Data Delivery Setup 

The Data Delivery tab (Figure 23) allows the user to schedule remote data 

delivery via email. 

• Delivery Start Time: Time of the day when data will be sent. 
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• Use SSL: Depending on the sender’s email server, the sender can 

activate the Secure Sockets Layer (SSL).  

• Use Authentication: Turning this on will require the receiver to 

provide a password and a username to access data.  

• Server: Enter server location. 

• User Name: Required when Use Authentication is turned on. 

• Password: Required when Use Authentication is turned on. 

• From: Sender’s email address. 

• To: Receiver’s email address. 

• Subject: Subject line of the email.  

• Data Directory: Location of the data you want email. 

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

 

Figure 23: Setup Tool – Data Delivery Tab  
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Editing Main GUI Properties 

The GUI Properties tab (Figure 24) allows you to set the number of line 

graphs visible on the main GUI and to enable valve sequencer control. 

In this tab, you can enable control of a connected Valve Sequencer from 

the main GUI: 

1. Click on “Settings” of the “Setup Tool” window, and then “Switch 

to Service” mode.  

2. Choose “Yes” next to “Enable Control Valve Sequencer” drop 

down menu on the “GUI Properties” tab.  

3. Click “Apply” to put changes into effect and then “Exit” to close the 

window. 

You should now be able to access the “Show/Hide Valve Sequencer 

GUI” menu from the main GUI under “Tools” 

 

Figure 24: Setup Tool – GUI Properties Tab 
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Command Interface – Specifying Digital Data Output 

The Command Interface tab (Figure 25) allows you to specify the data 

elements that are sent via COM port/TCP (specified in the Port Manager 

tab). Two types of data can be specified here: Output Data Source and 

Output Data Columns.  

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

 

Figure 25: Setup Tool – Command Interface Tab 
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Data Streaming – Specifying Digital Data Output 

The Data Streaming tab (Figure 26) allows you to specify the data 

elements that you want to send via COM port (specified in the Port 

Manager tab). Two types of data can be specified here: Data Stream 

Source and Data Stream Columns.  

Data Streaming outputs data continuously, whereas the Command 

Interface needs commands to prompt data output. 

 After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

 

Figure 26: Setup Tool – Data Streaming Tab 
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Customizing Analog Output Channels 

The Picarro analyzer may be optionally configured with an Electrical 

Interface Card (EIC) that provides up to 8 analog signals available to the 

user for monitoring various measurements results and analyzer 

parameters. 

Electrical Interface 

The Electrical Interface tab (Figure 27) allows you to customize each 

analog output channel. This tab will be disabled if your analyzer was not 

configured to work with an analog peripheral. 

After making the appropriate edits, click “Apply” to put changes into effect 

and then “Exit” to close the window. 

 

Figure 27: Setup Tool – Electrical Interface Tab 
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10. Calibration 
The primary analytical measurement of the G2910/G2920 instrument is the 

concentration of C2H4O (Ethylene Oxide or EtO) Periodic recalibration with 

standards of known concentration maintains the accuracy of these quantities. 

Using the Data Recal Software Utility (described in Section 10.3, Calibration 

Software Utility Tools) enables the calibration constants to be tracked over time, 

thus enabling the user to follow system performance. 

10.1 Slope and Offset 

Every Picarro analyzer ships with a default user calibration value of 1 for 

slope and 0 for offset. While new user calibrations will likely result in 

changes to both, we recommend that only offset changes are applied 

during more frequent calibrations. 

If a new slope calibration is to be applied, the user must be mindful of their 

experimental uncertainty. For example, a change in the slope calibration 

from 1 to 0.95 may not represent a change in the system’s linearity but 

may simply reflect the experimental uncertainty. If during your slope 

calibration, a new value of 0.9 or 0.85 is suggested by the Data Recal tool, 

please repeat the measurements of your standards. In most cases, such 

large changes in slope are a result of uncertainty and do not indicate a bad 

nonlinearity of the analyzer. If your analyzer continues to suggest a large 

change in slope, please consult with Picarro Support before applying a new 

calibration. 

 

NOTE 

If you are uncertain about the state of your current slope and offset values, 
they can be reset back to their user default values of 1 and 0, respectively. In 
your Picarro GUI, navigate to: 

“Tools → User Calibration → (password: picarro) →” Then change the slope 
and offset values of your parameter of interest to 1 and 0, respectively. 

10.2 Calibration Methodology 

To perform a calibration or verification of calibration, the user simply 

introduces the calibration standard into the analyzer for a period long 

enough for the analyzer to yield a stable measurement of that sample. 
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Calibration Setup 

This section describes the connections from the analyzer to the gas tank. 

• The pressure regulator at the outlet of the gas tank protects the 

analyzer from over-pressurizing. The pressure should be set to 

about 1 – 3 psi (68.9 mbar – 206 mbar). 

• The toggle valve allows rapid shutoff of the gas delivery. 

• Tubing is connected to the male quick-disconnect connector 

provided with the analyzer. 

• The male connector is inserted into the inlet port of the analyzer. 

To replace the gas tank:  

1. Turn off the main valve on the gas tank. 

2. Disconnect the pressure regulator assembly from the tank. 

3. Connect the pressure regulator assembly to the next gas tank. 

Measurement Time for Each Standard 

The measurement period for a calibration standard is dependent upon the 

recorded precision of the standard gas and performance characteristics of 

the analyzer, using the Allan standard deviation plot. 

Measuring Multiple Gas Standards 

When measuring multiple gas standards, the order of the gas standard is 

not important. However, make sure that you measure the gas standard 

slightly longer than the time you determined in the previous section 

because the usable/effective data set will be trimmed down. 

Calibration Data Processing 

1. Process the calibration results from the .dat file (see File 

Management on Page 41) and calculate the average recorded 

value for each standard. 

2. Plot these values versus the certified values from the gas supplier, 

and determine the linear relationship between the known 

calibration values and the analyzer’s reported values. A linear 

best-fit equation can be calculated from the data. 

 

NOTE 

It is important to plot the analyzer’s reported concentration on the horizontal 
axis and the gas standards’ stated concentrations on the vertical axis. 
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The slope and intercept of the best-fit line through these points are the two 

values that are used to calibrate the analyzer. By determining the linear 

relationship between the known calibration values and the analyzer’s 

reported concentration values in this way, a calibration offset (slope and 

intercept) can be calculated to add a correction term to the analyzer’s 

factory or previous calibration. 

Entering the Calibration Setting 

Changing the analyzer’s calibration is intended to be done infrequently. 

Instead of recalibrating frequently to increase the accuracy of the data, 

users often just verify the calibration by measuring three or more gas 

standards and use the same regression procedure described here to 

calculate an offset by which to correct their data offline. Using the following 

equation in the graph below, this calculation would be accomplished point-

by-point by calculating the corrected data “y” using the analyzer’s data “x” 

so that: 

Data corrected = 0.9866•Dataraw+5.268 

 

Figure 28: Linear Calibration Example 

Calibration values are input into the analyzer by selecting Tools → User 

Calibration, and then entering the slope and intercept for each species. 
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NOTE 

User Calibration is a password-protected form, and the default password is 
“picarro”. This password can be reset in the QuickGui.ini file as previously 
described. 

The calibration will take effect immediately after clicking OK.  

How to Return to Factory Calibration 

To return to the factory calibration, simply set the slope to 1 and the 

intercept to 0 for each species. 

10.3 Calibration Software Utility Tools 

Data Recal  

The Data Recal software utility is designed to enable users to perform a 

concentration calibration or calibration verification of Picarro’s gas 

concentration analyzer via a user-friendly interface.  

Data Recal allows the input of ten calibration points. Some of these points 

can be used for recalibration, while the remaining points can be used as 

quality control calibrants. In an ideal situation, three concentration certified 

standards should be analyzed on the system to generate CRDS-reported 

values for concentration. Standards spanning and encompassing the 

intended sample analysis should then be used to build a standard 

calibration curve. Parameters of this curve will then be used to correct the 

instrument readings so that they match standard values. The other 

standards will be simultaneously used for quality control, to verify other 

recalibrated values against their certified values. 

 

NOTE 

The following steps illustrate the Data Recal procedure for an isotopic delta 
calibration. The user can follow the same steps for a concentration calibration. 

Graphical User Interface (GUI) 

The Picarro Data Recalibration (“Data Recal”) software can be found in the 

“Picarro Utilities” folder on the desktop. The Data Recal software utility can 

be launched by double-clicking on the Data Recal Icon in the folder. Shown 

in Figure 29 below is a screenshot of the window that will open. 
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Figure 29: Data Recal Software Utility GUI 

The Delta Recal Software Utility comprises three sections: 

1. Numerical Input and Selection Section (Figure 30): 

Certified and CRDS reported values are entered in the white boxes. 

Standards that will be used for instrument recalibration are then 

selected by checking the corresponding box in the first column, 

labeled “Used for Recal.” 

 

Figure 30: Recalibration Section of Data Recal Software Utility GUI 
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2. Calibration Output Section (Figure 31): 

In the “Calibration Options” drop-down menu, you can select either 

an “Offset” or an “Offset + Slope.” Once the new calibration 

parameters are calculated, the Data GUI will display the new values 

under the “New Calibration” column. The parameters that appear 

here will depend on your initial selection. When the Offset + Slope 

option is selected, the program also calculates a goodness-of-fit 

correlation coefficient (R2). 

 

Figure 31: Calibration Output Section of Data Recal Software Utility GUI  

3. Action Selection Section (Figure 32): 

In this section, the user can click on the compute button to calculate 

the new calibration parameter(s). The compute button will be grayed 

out until values have been entered in the Certified and CRDS 

reported columns (Figure 30), and at least one pair of Certified and 

CRDS reported values selected for the calibration. Once these 

values are entered or selected, the “Compute” button will be active. 

Click “Compute” to calculate the new calibration parameters. These 

parameters will appear in the Calibration output section of the GUI, 

and an asterisk “*” will be displayed at the end of the window title 

line (Figure 33), indicating the new change. 

 

Figure 32: Action Selection Section of Data Recal Software Utility GUI 

Once the calibration parameters are calculated, you can elect to 

graphically display the calibration and quality control (QC) standards 

in a graph. To do this, click “Plot” in the upper left corner of the 

window, and select “Plot Linear Fitting” from the drop-down menu, 

as shown in Figure 33 below. 
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Figure 33: Delta Recalibration – Asterisk Indicating New Change 

The plot that the utility will generate is shown in Figure 34; this plot will 

display two graphs. The top graph presents measurements for the 

recalibrated standards (calibration and QC), as well as a line fit through 

those points. The bottom graph shows the residuals, which shows how far 

each measurement is from the best-fit line. 

 

Figure 34: Slope of Delta Recalibration 

If you decide to accept the new calibration values based on this plot, click 

on the “Apply New Cal” button (Figure 35 below). 

 

Figure 35: Apply New Calibration Slope and Intercept 
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You will then be prompted to enter a Calibration Password (Figure 36). The 

default Calibration Password is PICARRO. 

 

Figure 36: User Authorization Dialog 

Next, a “Recalibration Confirmation” pop-up window will appear, displaying 

the new offset and slope (when applicable) values. This window will prompt 

you to confirm your choice to apply these values, to avoid any inadvertent 

mistakes. 

 

Figure 37: Calibration Confirmation Pop-up 

Please note that when you click the “Yes” button, the newly accepted 

calibration parameters will take effect immediately, without the need for the 

instrument main GUI to be restarted. 

Once you accept the new calibration parameters, the Data Recal Software 

Utility automatically gives you the option to save the new recalibration file 

(Figure 38 below). Saving these files enables you to track the instrument 

recalibration history.  
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Figure 38: Delta Recalibration Save-As File Dialog 

Saved files can be reloaded by clicking “File” in the upper left corner of the 

window (Figure 39) and selecting “Load Recalibration File.” 

 

Figure 39: Delta Recalibration Load File 

Next, you would select and open the file that you want to load (Figure 40).  

 

Figure 40: Delta Recalibration Load File Dialog 
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The recalibration file for this example will contain the information shown in 

Table 8. 

Table 8: Delta Recal Log File 

Row Column 1 Column 2 Column 3 

1 –35.6 –35.8 –35.20437 

2 8.6 7.6 7.64690 

3 37.5 38.4 38.05748 

4 cc 1.75599 0.55625 

5 nc 1.87678 0.54922  

0.99949 

6 option Offset + Slope  

Rows 1 – 3: Values from each standard selected for recalibration. The 

first column in these rows lists the certified values, the second column lists 

the measured values, and the third column lists the recalibrated values. 

The number of rows will depend on the number of standards selected to be 

used for recalibration. 

Row 4 – Current Calibration (cc) Row: Read from left to right, lists the 

current offset and current slope value. 

Row 5 – New Calibration (nc) Row: Read from left to right, lists the new 

offset and new slope values. The third value in this row is the R2 value, 

which is only displayed if the calibration option is “offset + slope.” 

Row 6 – Options Row: The last row displays the calibration option 

selected. If you choose to exit the Recal GUI before accepting the new 

recalibration values, you will be prompted to confirm your choice through a 

pop-up window (Figure 41). This window contains a warning that 

continuing to exit will cause the new calibration data to be lost: 

 

Figure 41: Recalibration Exit Confirmation Pop-up 
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When you are finished with the calibration, you can exit the Delta Recal 

software utility by clicking on the “Exit” button at the bottom part of the 

Recal GUI. 

 

Figure 42: Exit Delta Recalibration Utility 

 

 

NOTE 

The Recal GUI will display an error message (Figure 43) saying the new slope 
value is not acceptable when one of the following occurs: 

a. At least two entries in the Certified or CRDS reported columns contain 

zero-value numbers. 

b. These entries are selected to be used for recalibration. 

c. The “Offset + Slope” calibration option is selected. This error occurs 

because the entered values will lead to an erroneous zero-slope value. 

 

 

Figure 43: Invalid New Slope Value Error Message 
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11. Troubleshooting 
The following section lists problems that may be encountered during installation 

and operation of the analyzer. The corresponding step-by-step procedures 

provide resolution in most cases. If, after attempting these procedures, the 

problem remains unresolved, please contact Picarro Technical Support. 

11.1 Power LED on Analyzer Does Not Illuminate 

Context: Turning on the analyzer by momentarily depressing its front 

panel power switch should apply power. The green power LED is 

illuminated when it detects the correct power levels. 

1. Check that the AC power cord is attached and plugged into a 

working outlet. 

2. Verify the rear on-off switch near the AC power cord is ON. 

3. Press and hold the front panel power switch for at least 5 seconds 

as the analyzer may take several seconds to respond. 

11.2 User Interface Program Does Not Start 

Context: The computer may be configured to start the instrument and the 

associated user interface program automatically after it completes its boot- 

up sequence, or the program may be launched using the “Start instrument” 

icon on the desktop. Communications problems with the analyzer may 

occur if the analyzer fails to initialize correctly on power up. Should the 

analyzer initialization process not complete correctly, shut down the 

instrument by shutting down the Windows operating system on the control 

computer:  

 

NOTE 

Do not simply restart Windows as this does not cycle the power to the 

analyzer. 

1. Use the Start menu, select the red Shutdown button and select 

“Shutdown” in the drop-down box under “What do you want the 

computer to do?”.  

2. Wait for the shutdown to complete normally and for the computer 

and analyzer to turn off completely.  

3. After a few seconds, restart the computer by momentarily 

depressing the power button. 
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11.3 Sample Pressure Not Controlled to Appropriate 
Value For Concentration Measurements 

Context: Under normal operation, the cavity pressure is automatically 

locked to the correct value by means of electronically controlled inlet and 

outlet valves. The message “Pressure Locked” on the front panel display 

and the user interface indicates that the cavity pressure is at the 

appropriate value. If messages stating “Pressure high” or “Pressure low” 

are displayed, the cavity pressure is out of its correct operating range. 

1. A “Pressure low” message indicates that there is insufficient gas 

available at the inlet of the analyzer. Check the inlet plumbing to 

the analyzer and ensure that the pressure at the inlet is within the 

specifications. 

2. A “Pressure high” message indicates that gas cannot be removed 

from the analyzer at a sufficient rate. Check the vacuum line 

between the analyzer and the power vacuum unit for leaks. Failure 

of the vacuum pump, injecting dilution gas at excessive pressure, 

or excessive pressure at the inlet can also cause this problem. 

11.4 UI Program “Freezes” – Does Not Update Graphs as 
Data Collected. 

Context: The computer may become unresponsive causing the programs 

that control the analyzer to stop functioning. The computer and analyzer 

should be shut down and restarted. 

1. Resetting the computer and the instrument requires that the 

computer is shut down and restarted. If the computer responds to 

the mouse, a normal Windows shutdown may be carried out: use 

the Start menu, select the red Shutdown button and select 

“Shutdown” in the drop-down box under “What do you want the 

computer to do?” Wait for the shutdown to complete normally and 

for the computer and analyzer to turn off completely. After a few 

seconds, restart the computer by momentarily depressing the 

power button. 

2. If the computer does not respond to the mouse, hold down the 

power switch on the front panel for a few seconds until the 

computer and the instrument turn off. After another few seconds, 

restart the analyzer by momentarily depressing the power button. 
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12. Service and Maintenance 

12.1 Consumables and Replacement Parts  

The following parts can be ordered directly from Picarro as needed over 

the lifetime of the analyzer. See Contact Information on Page 4. 

Table 9: G2910/G2920 Replacement Parts 

Part 

Number 
Description 

Expected Servicing 

Frequency 

S1020 Particulate filter kit for input sample line After 12 months 

C0360 Desiccant Drier Kit After 12 months 

S2009 Rebuild kit for A2000 Pump After 2-3 years 

S2068 Complete fan replacement kit After 2-3 years 

A2000 External vacuum pump After 40,000 hours 

12.2 Particulate Filter Replacement 

There are two inline, sub-micron particulate filters before the measurement 

cavity. The first is user-replaceable and replacement filters can be 

purchased from Picarro and installed by the user.  

 
CAUTION 

Equipment Damage: Never remove the filter that is directly attached to the 
cavity. Only change the filter immediately following the inlet at the back of the 
analyzer. 

The symptoms of a clogged filter can be analyzed reporting “pressure low” 

or there being no flow into the instrument, causing unusual measurements. 

Filters can become clogged after years of use in dirty environments.  

 
WARNING 

If liquid water is accidentally sucked into the inlet line, it will clog the 

filter and impede the flow (usually for a few days) until it evaporates. If 

this occurs, it is important to NOT turn off the analyzer or replace the 

filter until it is dry.  

The reason for this is that the increased humidity due to liquid water in 

the filter can cause condensation on the optics if the analyzer is allowed 

to cool from its operating temperature. Often, after the filter dries, the 

analyzer will begin functioning normally, and a filter replacement is not 

necessary. 
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Required Tools 

• 2 mm Hex driver 

• 9/16” open-end wrench 

• 5/8” open-end wrench 

• 11/16” open-end wrench 

Removing the Old Particulate Filter 

1. Move the analyzer to a clean work environment. 

2. Using a 2 mm hex driver, remove the top lid of the analyzer by 

removing six M3 x 6 mm socket flathead screws. 

3. Loosen and remove the 2 screws on the inner long side of the 

bigger box (Figure 44), then lift and open the inner cover. 

 

Figure 44: Opening G2910/G2920 Inner Cover 

4. Remove the foam pieces as shown in Figure 45. Slide the larger 

foam piece toward the left side of the analyzer (as viewed from the 

back of the analyzer) to remove it. 

5. Using a 5/8” wrench, loosen the retaining nut on the input bulkhead 

(about 1 full turn should be enough – See Figure 45). 

6. Using a 9/16” and 11/16’ wrenches, loosen input and output nuts 

that connect the filter to the analyzer (See Figure 46 and Figure 

47). 

Lift inner cover 

Remove two 
screws 

Remove two 
screws 

Filter location 

Rear Panel 
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Figure 45: Foam Removal and Loosening Retaining Nut  

 

 

Figure 46: Loosening Filter Input Nut 

 

Remove foam 
to expose the 
filter 

Filter 

Loosen the retaining nut at 
the input bulkhead. 

Loosen the filter input 
nut with a 9/16” 
wrench. 

Hold the filter steady with 
an 11/16” wrench. 

Loosened 
Retaining Nut 
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Figure 47: Loosening Filter Output Nut 

7. Slide the filter slightly toward the back of the analyzer and lift it out. 

 

Figure 48: Filter Removed 

Loosen the filter output 
nut with a 9/16” wrench. 

Hold the filter steady with 
an 11/16” wrench. 
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Installing the New Filter  

 
CAUTION 

When installing the new filter, to ensure proper gas flow direction, make sure the 
arrow on the filter is pointing away from the back panel of the analyzer as shown 
in Figure 49. 

 

 

NOTE 

When re-attaching 1/4” Swagelok fittings, the nut should be hand-tightened 
and then turned an additional 1/8 of a turn using a wrench. 

1. Remove new the filter from its packaging. 

2. Position the new filter between the inlet and outlet fittings and 

attach the inlet and outlet nuts to each end. The flow direction 

arrow on the filter should point away from the analyzer rear panel 

(Figure 49). 

3. Using a 9/16” and 11/16’ wrenches, tighten the two nuts.  

 

Figure 49: Filter Installation – Ensuring Correct Flow Direction 

4. Using a 5/8” wrench, tighten the retaining nut at the bulkhead 

fitting.  

5. Reposition the foam filter cover. The metal edge of the filter cover 

should be under the foam. 

6. Close the inner lid and secure with the two screws on the inner 

long side of the bigger box. 

Retaining 
Nut Outlet Nut Inlet Nut 

New Filter in Correct 
Flow Direction 
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7. With a 2 mm hex driver, attach the analyzer top cover with six 

screws. 

12.3 Cleaning 

Clean the outside of the analyzer with a clean dry cloth. Only certified 

service technicians should access or clean the inside of the analyzer. 
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13. Transportation and Storage 
If the instrument will be transported or stored, the following procedure can be 

used to prepare the instrument and repack it into the original carton. 

13.1 Packing the Analyzer 

1. Shutdown the instrument using the shutdown button, using the 

“prepare for shipment” option. 

2. Clean dry gas should be attached to the instrument prior to 

shutting down. This prevents condensation inside the system 

during storage or shipment. 

3. Disconnect all tubing and electrical connections from the analyzer. 

4. To prevent contamination and possible damage to the connector 

threads, place caps on all gas connections. 

5. Place the analyzer in a plastic bag with a package of desiccant.  

Seal the bags with tape. 

6. Pack the analyzer in the original shipping container ensuring that 

all the foam pieces are in place to protect the analyzer during 

shipping. 

  
CAUTION 

Prevent Equipment Damage: When shipping or relocating the analyzer, it is 
important to protect it from mechanical shocks. Failure to do so can 
compromise its performance. When shipping the analyzer, use its original 
packaging only. 
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14. Limited Warranty 
Picarro, Inc. warrants its Products to be free from defects in material and 

workmanship and to perform in the manner and under the conditions specified in 

the Product specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products 

and no person is authorized to bind Picarro for any obligations or liabilities 

beyond this warranty in connection with its Products. This warranty is made to 

the original Purchaser only, is non-transferable and may only be modified or 

amended by a written instrument signed by a duly authorized officer of Picarro. 

Sub-systems manufactured by other firms, but integrated into Picarro Products, 

are covered by the original manufacturer’s warranty and Picarro makes no 

warranty, express or implied, regarding such sub-systems. Products or parts 

thereof which are replaced or repaired under this warranty are warranted only for 

the remaining, un-expired portion of the original warranty period applicable to the 

specific Product replaced or repaired. 

 

NOTE 

DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL, OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN 
CONTRACT OR OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY 
DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be 

to have Picarro repair or replace such defective Product or credit the Purchaser’s 

account, whichever Picarro may elect in its sole discretion. If it is found that any 

Product has been returned which is not defective, the Purchaser will be notified, 

and such Product returned at the Purchaser’s expense. In addition, a charge for 

testing and examination may, at Picarro’s sole discretion, be made on any 

Product so returned. 

These remedies are available only if: 1) Picarro is notified in writing by the 

Purchaser promptly upon discovery of a Product defect, and in any event within 

the warranty period; 2) Picarro’s examination of such Product discloses to 

Picarro’s satisfaction that such defects actually exist and the Product has not 

been repaired, worked on, altered by persons not authorized by Picarro, subject 

to misuse, negligence or accident, or connected, installed, used or adjusted 

otherwise than in accordance with the instructions furnished by Picarro. 

The following warranty conditions shall apply to all Picarro, Inc. products unless 

amended by a written instrument signed by a duly authorized officer of Picarro: 
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ADJUSTMENT: No electrical, mechanical, or optical adjustments to the 

product(s) are permitted. 

PARTS AND LABOR:  New or factory-built replacements for defective parts will 

be supplied for twelve (12) months from date of shipment of the product. 

Replacement parts are warranted for the remaining portion of the original 

warranty period. There will be no charge for repair of products under warranty 

where the repair work is done by Picarro, Inc.  

NOT COVERED BY THE WARRANTY: Damage to any optical surface from 

improper handling or cleaning procedures. This applies specifically to those items 

subjected to excess laser radiation, contaminated environments, extreme 

temperature, or abrasive cleaning. Damage due to ESD, abuse, misuse, 

improper installation or application, alteration, accident, negligence in use, 

improper storage, transportation, or handling. No warranty shall apply where the 

original equipment identifications have been removed, defaced, altered or where 

there is any evidence of alterations, adjustments, removal of protective outer 

enclosure, any attempt to repair the product by unauthorized personnel or with 

parts other than those provided by Picarro, Inc.  

DAMAGE IN SHIPMENT: The analyzer should be inspected and tested as soon 

as it is received. The product is packaged for safe delivery. If the product is 

damaged in any way, you should immediately file a claim with the carrier or, if 

insured separately, with the insurance company. Picarro, Inc. will not be 

responsible for damage sustained in shipment. All Picarro products are F.O.B. 

origin, shipped from the Picarro factory or Picarro distributor. The price of all 

Products, unless otherwise specifically stated, is Ex- Works, Sunnyvale, CA as 

defined by Incoterms, 2001. The cost of normal packaging for shipment is 

included in the invoiced price. Where Buyer specifies special packaging, a 

charge will be made to cover any extra expense. 

CLAIMS ASSISTANCE: Call Picarro, Inc. Customer Service or your local 

distributor for assistance. Give our representative the full details of the problem. 

Helpful information or shipping instructions will be provided. If requested, 

estimates of the charges for non-warranty or other service work will be supplied 

before work begins. 

RETURN PROCEDURE: Customers must obtain a Return Merchandise 

Authorization Number from Picarro, Inc. prior to returning units. Products being 

returned for repair must be shipped in their original shipping cartons to avoid 

damage. 



Remote Data Access   

G2910/G2920 UM P/N 40-0076 Rev. A 77 

Remote Data Access 

A.1 Picarro Serial Communication 

The analyzer supports an RS-232 physical command interface, which can 

be used to control the instrument and to retrieve concentration data. Not all 

features of the instrument are available on the serial interface. For details 

on how to use the serial command interface, please see the Programming 

Guide. This command set may also be used across a TCP/IP interface 

through an Ethernet connection. Please contact Picarro for further details. 

A.2 Remote Data Access 

Using the RemoteAccess.ini file, the analyzer can be configured to 

automatically: 

• Send data from the instrument to a list of e-mail accounts. 

• Measure the offset of the host computer system clock from a set of 

Internet time servers and (optionally) to resynchronize the clock 

based on this information. 

The Internet connection need not be permanent and may be a dial-up 

connection accessible via a user-supplied USB modem. The task of 

sending data and/or synchronizing the clock on the analyzer is performed 

using the C:\Picarro\G2000\HostExe\RemoteAccess.exe program. This 

program can be set up to run periodically using the Windows task 

scheduler at a user-configurable frequency. If a dial-up connection to the 

Internet is employed, it is used only on demand to minimize the connection 

time. 

Each time that the RemoteAccess.exe program runs, it appends 

information to a log file, which keeps a record of the results of the time 

synchronization and of the files sent by e-mail. The RemoteAccess.exe 

program is configurable by means of an initialization file, which includes 

information such as the login credentials for the dial-up connection, the e-

mail account, and the list of time servers. 

The initialization file is: 

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\Remote

Access.ini 
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It should be placed in the same directory as the executable 

RemoteAccess.exe. The file has one required section named LOGGING 

and three optional sections named NTP, DIALUP, and EMAIL. The logging 

section has a single key Logfile whose value is the path to the log file. 

Once this log file exceeds 64K bytes in length, it is backed up, appending a 

numeric extension to the file name, and a new file is opened. A total of ten 

backup log files are kept. 

NTP 

The NTP section controls querying the Internet time servers using the 

SNTP protocol (RFC4330) and the resetting of the clock on the host 

computer. If the section is not present, time synchronization is not carried 

out. The keys Server1, Server2, etc., are used to specify the URLs of the 

time servers. If the UpdateClock key is set to “true,” the offset is applied to 

the host clock. Otherwise, the offset is recorded, but the host clock is not 

changed. 

Email 

The EMAIL section controls the sending of the data files as e-mail 

attachments. If the section is not present, e-mail messages are not sent. 

The key Directory specifies the directory that contains the data files. When 

the program is run, files in this directory are sent to the specified recipients 

and the files are deleted. To avoid problems with incomplete files, 

programs that place files into this directory should do so using an atomic 

operation, such as a rename. The Server key is set to the name of an 

RFC2821- compliant SMTP server that sends the e-mail messages. 

The From key is the e-mail address from which the messages are sent. 

Note that some SMTP servers check that the source is permitted to send 

email while others allow any name in this field. The collection of e-mail 

addresses to which copies of the e-mail is sent is specified by the keys 

To1, To2, etc. The Subject key is used to fill the subject field in the email 

header and may be set to any string. Depending on the SMTP server, it 

may be necessary to use authentication before e-mails can be sent, as 

described in RFC2554. If such authentication is not needed, the key 

UseAuthentication is set to false. If this key is set to true, two additional 

keys Username and Password must also be specified for the e-mail 

account. 
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Dial-up 

The DIALUP section is used if a dial-up connection to the Internet needs to 

be established when the program runs. If the section does not exist, a 

permanent connection is assumed to be available for carrying out the other 

tasks specified in the initialization file. The connection name key specifies 

the name of the dial-up connection to use, as listed under Network 

Connections in the Control Panel. The values of the keys Username, 

Password and Number are used to make the connection. 

Table 10: Examples of RemoteAccess.ini File 

[LOGGING] Logfile=c:/temp/RemoteAccessLog 

[NTP] 

Server1=time-a.nist.gov  

Server2=time-b.nist.gov 

Server3=time-a.timefreq.bldrdoc.gov 

Server4=time-b.timefreq.bldrdoc.gov  

Server5=time-c.timefreq.bldrdoc.gov 

Server6=time.nist.gov 

Server7=time-nw.nist.gov 

UpdateClock=1 

[DIALUP] 

ConnectionName=Picarro Dialup  

Access Username=user 

Password=password Number=14085551212 

[EMAIL] 

Server=smtp.servername.org  

Directory=c:/picarro/mailbox  

From=instrument@picarro.com  

To1=recipient1@site1.com  

To2=recipient2@site2.com 

Subject=CRDS data from Silverstone instrument UseAuthentication 

mailto:From=instrument@picarro.com
mailto:To1=recipient1@site1.com
mailto:To2=recipient2@site2.com
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The Data File Viewer 

B.1 Introduction 

The Picarro Data File Viewer software is located in the Picarro Utilities 

folder on the desktop. The software allows the user to graph and to 

conduct statistical analysis of the raw data. Additional functions include 

Allan Variance plot and quadratic or polynomial fittings. 

The Picarro Data File Viewer includes two main menus: File (Figure 50) 

and New (Figure 51). 

 

Figure 50: File Menu 

 

 

Figure 51: New Menu 
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B.2 The File Menu 

This section describes the functions available from the Data File Viewer 

File menu. 

Open H5 

File > Open H5 File: Opens a Picarro data file (HDF5 format) for data 

analysis and visualization. After opening the data file, you can create a new 

time series plot. Refer to Section B.3, New – Time Series Plot for more 

information. 

Load Config 

File > Load Config: Loads a configuration file (ini format) to restore 

parameters of a workplace. Refer to Save Configuration on Page 86 for 

more information. 

Unpack Zip File 

File > Unpack Zip File: Use to concatenate all H5 files inside the zip file 

into a single H5 file. Refer to Concatenate H5 Files below for details. 

Concatenate H5 Files 

File > Concatenate H5 Files: Use to concatenate multiple files and zip 

archives of H5 files into a single H5 file. Navigate to the desired folder or 

use the Define Date Range button to specify a date range of files to 

concatenate. (See next section.) 

After selecting the path of the data files, Data File Viewer will automatically 

search an H5 file in the specified zip/folder and look for all available 

variables in the H5 file. The variables are then listed in the Select 

Variables window in the left panel (as shown in Figure 52), and users can 

use  the “>>“ button to move variables to the right panel for concatenation. 
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Figure 52: Select Variables Form 

Define Date Range 

Data File Viewer can search data files within the desired date range and 

then concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were 

taken elsewhere, select the time zone where data were taken. 

Select File > Concatenate H5 Files, then click Define Date Range to 

specify the desired date range as shown in Figure 53. 

 

Figure 53: Define Date Range Dialog 
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Data files are saved in directory trees named by date and time option.  

Picarro software saves data in a directory tree that is named by the 

creation year, month, and day as shown in Figure 54. Select this option if 

the target folder has this file structure. This way, Data File Viewer will only 

search folders within the desired date range, which can substantially 

reduce processing time. 

 

Figure 54: File Structure of Data File Viewer   

 

 

NOTE 

To save processing time, Data File Viewer does not open data files, but only 
determines data acquisition time based on the file name. 

 

 
CAUTION 

Do not define a time range for data files whose names have been changed. 

 

 

NOTE 

Data File Viewer does not concatenate data files exactly within the defined 
time range. This is because the time extracted from file name is different from 
the data acquisition time. To not miss data points, Data File Viewer expands 
the specified time range, so the resulting dataset normally has a wider time 
range than the user specification. 

Convert DAT to H5 

Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 

format. These formats are described below: 

• DAT format: DAT files accepted by DatViewer store tabular data 

(numbers and text) in plain text. 

• Each line of the file is a data record. Each record consists of one or 

more fields separated by whitespaces. 

• The first line of data file indicates column names. 
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• There must be a field “EPOCH_TIME” to store the acquisition epoch 

time (expressed as seconds since Jan 1, 1970) of the data. 

Otherwise, the first and second fields must be “DATE” and “TIME”. 

The “DATE” field must have the format “mm/dd/yyyy” or “yyyy-mm-

dd”, and the “TIME” field must have the format “HH:MM:SS(.sss)” 

where (.sss) is an optional fraction of seconds. 

• HDF5 Format: HDF5 is a data model, library, and file format for 

storing and managing data. (See the HDF5 Home Page on the HDF 

Group website for more information.) When converting DAT to 

HDF5 format, Data File Viewer creates a table named “results” to 

the contained data. 

Convert H5 to DAT 

Select File > Convert H5 to DAT to convert a file in a HDF5 format to 

DAT. These formats are described in Convert DAT to H5. 

  

NOTE 

Data File Viewer does not concatenate data files exactly within the defined 
time range. This is because the time extracted from file name is different from 
the data acquisition time. To not miss data points, Data File Viewer expands 
the specified time, column name “fineLaser-Current_1_controlOn” will be 
replaced with “fineLaserCurr_1_ctrlOn”. 

Interpolation 

Interpolation describes the method for constructing data points with a 

range of a discrete set of known data points. Select File > Interpolation to 

perform interpolation on a time grid with a constant interval. 

Block Average 

Select File > Block Average to divide a dataset into small blocks based on 

a user-defined block size. The average is calculated for data in each block, 

and the results are saved in a new H5 file. 

 

NOTE 

The specified block size must be greater than the average data interval. 

Because the data interval is normally not a constant (unless interpolation is 

performed), fluctuations in the data interval will affect block averaging if the 

block size is comparable to the average data interval. 

https://www.hdfgroup.org/
https://www.hdfgroup.org/
https://www.hdfgroup.org/
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B.3 New – Time Series Plot 

You can specify to include create time-series plots with one, two, or three 

frames. New plots display in the Time Series Viewer. 

 

Figure 55: Time Series Viewer 

The next section describes the options available on the Time Series Viewer 

menu bar. Refer to The Time Series Viewer Canvas on Page 89 for more 

information on the Time Series Viewer UI features and options. 

B.4 Time Series Viewer Menus 

The Time Series Viewer form includes the following menus: 

 

Figure 56: Time Series Viewer Menus 
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Time Series Viewer File Menu 

Use the File menu to save a configuration or take a screenshot. 

 

Figure 57: Time Series Viewer – File Menu 

Save Configuration 

Click File > Save Configuration to open the Feature Capture form. With 

this form, you can save figure properties, expressions, filters, and other 

settings to a configuration file so that it can be easily loaded in the future. 

 

Figure 58: Time Series Viewer – Feature Capture 

 
CAUTION 

If a feature is not captured, it will be omitted when the configuration file is 
loaded. 

Depending on the features captured, loading a configuration file can have 

different effects. For example: 

• If all features are captured, a saved workplace is reproduced. 

• If Data file is not captured, saved parameters will be applied to the 

data file in memory. 

• If Expression is not captured, plots will not be transformed. 

• If X (Y) range is not captured, figures will be auto-scaled on the x (y) 

axis. 
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Take ScreenShot 

Use File > Take ScreenShot to take a screenshot of the Time Series 

Viewer and save it as a .png to a specified file. 

Time Series Viewer Analysis Menu 

Use the Analysis menu to calculate statistics, generate a histogram, and to 

plot correlations and Allan Standard deviations. 

 

Figure 59: Time Series Viewer – Analysis Menu 

Statistics 

Use Analysis > Statistics to calculate mean, standard deviation and peak 

to peak for all plots in the current window. 

Histogram 

Use Analysis > Histogram to generate a histogram of data as shown in 

Figure 60 below. 
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Figure 60: Histogram Window – EtO 

• Red Line: A Gaussian function fitted to the histogram. Fitting results 

of μ and σ are shown in the top-left corner of the plot. 

• Bin: Specifies the number of intervals that the range of values is 

divided into. 

• Normalized: When selected, the sum of the histograms is 

normalized to 1. 

• Save data: Saves histogram data to a CSV file. 

• Save image: Saves the histogram image as a JPEG/PNG/PDF file. 

Correlation Plot 

Use Analysis > Correlation Plot to plot Y-axis data in one frame versus 

that in the other. This can be used when two or more frames exist in the 

current Time Series Plot window. See Correlation/XY Plot on Page 92 for 

details. 
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Allan Standard Deviation Plot 

Use Analysis > Allan Standard Deviation Plot to create an Allan 

Standard Deviation plot (versus a standard deviation plot) for data in the 

current window. See Allan Variance Wikipedia page for more information. 

Time Series Viewer View Menu 

Use the View menu to view X-axis information in date-time, minute, or hour 

format. 

 

Figure 61: Time Series Viewer – View Menu 

 

 

NOTE 

When switching from DateTime to Minute or Hour, the X-axis data is 
subtracted from the earliest point shown in the panel and then converted to 
the desired unit. 

The Time Series Viewer Canvas 

The Time Series Viewer canvas (Figure 62 below) is comprised of 

interactive graphs and a variety of configuration options. 

Mouse Options and Graph Transform 

The following mouse actions can be used in the canvas graphs: 

• Left click and drag: Zooms into the selected area of the plot. 

• Left click and drag with the SHIFT key down: Pans the plot. 

• Left click and drag with CTRL key down: Zooms out from the plot. 

• Left click and drag with ALT key down: Stretches the plot. 

• Right-click: Opens an additional menu. Refer to Right-click Menu 

below in the next section. 

 

https://en.wikipedia.org/wiki/Allan_variance
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Figure 62: Time Series Viewer Canvas 

Right-click Menu 

Right-clicking on the canvas opens a pop-up menu: 

 

Figure 63: Canvas Right-click Pop-up Menu 

Export Image: Exports the current plot as a jpeg, png, or pdf file. 

Export Data in Current View: Exports only date/time and the selected 

variable in the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of 

the selected dataset in the current time range to an HDF5 file. Refer to 

Concatenate H5 Files on Page 81 for more information. 

Edit Plot properties: Opens the Image Editor form (Figure 64 below), 

where the following options can be specified: 

• Title: Edits the title of the plot. 
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Figure 64: Image Editor Form 

• Line: Specifies the line pattern of the plot. If None is selected, the 

data points will be plotted without connecting lines. 

• Marker: Specifies the marker type to indicate data points. If None is 

selected, data points will not be shown. 

• Min and Max: Specifies the minimum and maximum of data range 

for the X-axis and the Y-axis. 

• x[0]: Sets the earliest time of the dataset as the minimum of the X-

axis. 

• Time zone: Sets the time zone for date/time variables. This defaults 

to the local time zone. 

Label: Specify a label for the X-axis and the Y-axis. 

Statistics: Calculates the mean, standard deviation, and peak to peak for 

data in the current view. 

Dataset Name and Var Name 

An HDF5 file can store one or more tables. Each of these tables is called a 

Dataset. A table can contain one or more columns. Each column is called a 

variable (Var). 

Use the Dataset name drop down to select the dataset that will be used for 

this time series graph. Use the Var name drop down to select the column 

in the dataset to use in the graph. 
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Autoscale Y 

When the Autoscale Y option is selected, the Time Series Viewer will 

autoscale on the Y-axis to make sure that all data within the range of the 

X-axis is displayed. 

Average 

If Block is selected, a block average is calculated when you click the Do 

average button. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a 

moving average, Size specifies subset size in unit of data points. 

 
REMINDER 

Averaging is performed after the Filter and Expression are performed. 

Mean, Std Dev, and Peak to Peak 

The Mean, Std dev (Standard deviation) and Peak to peak fields provide 

all the statistical information of data in the current view. 

Correlation/XY Plot 

The Correlation/XY Plot window (Figure 65) includes two menu items: File 

and Analysis. For details about the File menu, see Save Configuration on 

page 86. 

  
REMINDER 

The canvas in this plot is interactive. For details about the plot canvas, see 

The Time Series Viewer Canvas on Page 89. 
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Figure 65: Correlation XY Plot 

Analysis Menu 

The Analysis Menu (Figure 66) includes three options: Fitting, Integration, 

and Statistics. 

Fitting allows you to specify one of four fitting methods to include in the 

Correlation/XY plot: 

1. Linear fit: Specifies to fit to linear function: 

y = c1x + c0 
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2. Quadratic fit: Specifies to fit to quadratic function:  

y = c2x2 + c1x + c0 

3. Polynomial fit: Specifies to fit polynomial function of degree n:  

y = Σcnxn 

4. Curve fit: Specifies to use non-linear least squares to fit an 

arbitrary function to data.  

 

Figure 66: Analysis Menu 

Integration calculates area under the curve using the composite 

trapezoidal rule. 

Statistics calculates mean, standard deviation, and peak to peak for data 

in the current view.  

After applying any of the above Analysis options, the results, statistics, or 

fitting function with coefficients are displayed in the lower portion of the 

Correlation Plot window (Figure 67).  

 

Figure 67: Results of Quadratic Fitting 
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External Valve Sequencer 

C.1 Introduction 

The Picarro analyzer can control two types of valves: 

• Rotary Selector valve: digitally controlled valve used to send 

selected flow from one of many inputs (up to 16) into the analyzer. 

• Solenoid valve(s): DC voltage powered valve with normally open 

(NO) and normally closed (NC) positions. These can be either 

2-way or 3-way valves. 

Both types of valves can be simultaneously controlled through a common 

software interface called the ‘External Valve Sequencer described in 

Section C.5 which is available from the Tools menu on the GUI. 

 

NOTE 

Picarro offers a rotary valve solution with the A0311 16-Port Distribution 
Manifold (shown in Figure 68). The Distribution Manifold and GUI makes it easy 
to program the sequence and duration of sample intake from various attached 
sampling lines, flasks, or bags. The manifold is controlled using either the 
Picarro analyzer GUI or an external hand-pad (included with the A0311). 

The A0311 sequentially samples up to 16 gas sources. During operation, the 
selected line is routed through the valve into the analyzer. The 15 lines that are 
not selected terminate in the valve. 

For detailed instructions on integrating the A0311 with your analyzer, refer to 
the A0311 16-Port Distribution Manifold User Manual (P/N 40-0038). 

 

       

Figure 68: A0311 – 16-port Distribution Manifold 
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NOTE 

For users who require faster response performance, Picarro offers the 
A0311-S Fast Multipoint Sampler (Figure 69); a 16-Port Sequencer with a 
flow-through valve for reduced memory effects. Designed to optimize 
response time in the presence of reactive gases, the A0311-S uses SilcoNert 
coated components and an additional vacuum pump.  

The sampling duration and sequence is easily programmed through the 
Picarro analyzer graphical user interface. This design is ideal for fast 
switching between different locations, large coverage areas and for specialty 
applications in Semiconductor, Pharmaceutical, Environmental research, and 
other industries. For further technical, and purchase information, please visit 
www.picarro.com/  

For detailed instructions on integrating the A0311-S with your analyzer, refer to 
the A0311-S 16-Port Sequencer User Manual (P/N 40-0023). 

 

 

Figure 69: A0311-S – 16-Port Sequencer – Fast Multipoint Gas Sampler 

C.2 Default Configuration 

For all models of Picarro analyzers, the rotary valve control is disabled in 

the factory default setting. The solenoid valve control, however, is ready to 

use by default for all solenoid valve connectors.  

To configure an A0311 or A0311-S for rotary valve control, refer to Setup 

Tool; Port Manager in Section 9.5 for instructions to change to rotary 

valve configuration (the Valve Sequencer MPV field) and to ensure the 

correct COM port is enabled. 

  

https://www.picarro.com/
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C.3 Setting Up Solenoid Valves 

The Valve Sequencer software can control up to six solenoid valves. Each 

valve should operate using 12 VDC with a maximum quiescent current of 

500 mA. This analyzer comes with a cable that can be connected to the 

solenoid valves. 

The valve connector cable should be connected to the 15-pin connector at 

the lower left corner of the analyzer. There are six pairs of wires with 

connectors labeled V1, V2, … V6 with 2-pin female Molex connectors 

(Molex#43020-0200) for connection to the solenoid valves. For valves 

wired with matching Molex connectors, connect V1 to the solenoid valve 1, 

V2 to solenoid valve 2, etc. Do not connect the solenoid valve to the 

analyzer ground -- use only the provided electrical connectors.  

C.4 Setting Up Rotary Selector Valve 

The 9-pin female connector cable should be attached to its corresponding 

9-pin male port (COM 2) on the analyzer. The other end of the cable 

connects to the 9 pin port on the A0311. Please note the 9-pin connector 

cable is not supplied with the instrument. 

C.5 External Valve Sequencer Software 

The External Valve Sequencer software allows the user to set steps in 

which solenoid valves are turned on/off and the rotary selector valve is set 

to a single position. The Picarro valve sequencer window appears below: 
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Figure 70: Valve Sequencer GUI 

The current step, elapsed duration, and valve states are shown in the 

topmost row of the valve sequencer command window. The duration of 

each step is set in minutes; for example, 1 minute and 30 seconds 

correspond to 1.5 minutes. 

Please note the number of steps correlates with the total steps in the 

sequence, and the count of the steps starts at “0.” The first step in the 

sequence is designated Current Step “0,” and the second step in the 

sequence is designated Current Step “1.” The “Go to First Step” menu item 

under “Action” restarts the sequence from step 1. 

Different sequences can be created and saved in the software. Use the 

“Sequence File #” field to select which file the sequence will be saved to 

(0 to 10 are the available choices). Click the up/down arrows to select the 

desired number. 
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C.6 Configuring a Valve Sequence 

Each “step” sets the rotary valve to a single position and activates the 

indicated solenoid valve(s) for a set period. Multiple steps can be carried 

out in sequential order to switch between different gas sources, flush out a 

manifold, or other gas handling operation. Create the number of desired 

steps in the sequence by clicking the up/down arrow for “steps.” 

For each step, select the box for each solenoid valve to be opened. The 

checkmark in the “current valve state” window indicates a solenoid valve is 

open. Note: In this example, we assume normally closed (NC) valves are 

used. A check indicates current is flowing to the valve thus powering it 

open. The positions from left to right correspond to solenoid valves 

V1…V6. 

The rotary selector valve position can be set in the column labeled “Rot. 

Valve Code.” Enter the number that corresponds to the desired valve 

position. A value of 1 in this field corresponds to position 2 on the Valco 

valve. Only one rotary position can be selected per step. 

Step duration is determined by the value entered in the “duration (min)” 

field, where the duration of the step is in minutes. If duration values are set 

to <0.1 minutes, they may not be carried out correctly. 

The “Valve Code” column (not used with the A0311) is a configuration- 

dependent, read-only display field that shows the total state of that 

particular step in a numerical code. Should the most upper right gray box 

display a value of 512,256 or be grayed-out, either no rotary selector valve 

is connected to the instrument, or the valve is not functioning.  

For each individual measurement, the analyzer makes, the valve codes 

and rotary valve positions corresponding to the valve state(s) at that point 

in time are saved alongside the concentration data. 

Once the valve sequence has been programmed, it can be saved using the 

button “Save Valve Sequence File.” The sequence will be saved under the 

sequence file number selected. 

C.7 Loading and Running a Saved Sequence 

To load a valve sequence file, select the desired “sequence file number” 

and press “Load Valve Sequence File.” If the user has been running a 

different sequence from the one that was loaded, the user needs to press 

“Next Step” to initialize the newly selected sequence. 
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To run a sequence file, press “Enable Sequencer.” This button will turn to 

“Disable Sequencer” once the sequence starts. (The sequencer should be 

activated if it was disabled, but not necessarily to change from one 

sequence to another.) The sequence will repeat itself indefinitely until 

disabled or the software is exited. If enabled, the sequence will continue to 

run after the “close sequencer window” button is pressed. 

If desired, the valve sequence can be forwarded to the next step of the 

sequence by pressing the “run next step” button. To stop the sequencer 

file, use the “Start/Stop Sequencer” menu item under the “Action” menu. 

This will leave all valves in their current state. In some situations, it is 

convenient to program the last step in the sequence to be a safe or default 

valve state. The sequencer can be advanced to the last step should the 

user need to put the solenoid or rotary valves into a safe/default state. The 

“Reset All Valves” de-activates all valves. Using the “Hide Sequencer 

Interface” closes the window, but if the sequencer is enabled, it will 

continue to run in the background. To jump to a particular step, increment 

the “run step 3” and click “Apply.” 

Both solenoid and rotary valve codes are recorded in columns in the output 

data files indicating the active valve configuration respective to when data 

is taken. These codes can be used as event timing flags. For example, if 

no solenoid valves are present, the codes will be recorded regardless of 

whether a valve is connected or not. 

Load saved sequence files by clicking File/Load Valve Sequence. All the 

sequence files are in: 

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File 

1. Click Apply to run the sequence. 

To skip the next step click Run Next Step (even while in middle of 

running a step): 

2. Click on the Action scroll-down menu. 

3. Reset all Valves by changing all the Rot. Valve Code fields to zero. 

4. Click on Go to the First Step (Whatever the step the sequencer is 

at, step 1 will be played). 

5. Click on Start/Stop Sequencer (While the sequence is running, it 

will read Stop Sequencer). 

6. Click on Hide Sequencer Interface (to hide the External Valve 

Sequencer window). 
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Relative Humidity 
Conversion 

H2O Concentration (C) is reported in units of parts per hundred or percent (%) and is a 

volumetric fraction of water vapor to total (wet) gas. Via the ideal gas law, the 

concentration can be related to the water vapor pressure (PW) and the total pressure (P). 

𝐶𝑤𝑒𝑡 = 100 ∙
𝑃𝑊

𝑃
 

A popular way to express volumetric concentration when working with humidity is in 

terms of total (dry) gas. 

𝐶𝑑𝑟𝑦 = 100 ∙
𝑃𝑊

(𝑃 − 𝑃𝑊)
 

The two concentration definitions can be related by 

𝐶𝑑𝑟𝑦 =
100 ∙𝐶𝑤𝑒𝑡

(100−𝐶𝑤𝑒𝑡)
 or 𝐶𝑤𝑒𝑡 =

100∙𝐶𝑑𝑟𝑦

(100+𝐶𝑑𝑟𝑦)
 

Relative Humidity (RH) is the percentage of water vapor pressure to the saturated water 

vapor pressure (PWS). 

𝑅𝐻 = 100 ∙
𝑃𝑊

𝑃𝑊𝑆
 

There are several empirically generated equations that provide the saturation vapor 

pressure as a function of temperature (T). A simple and effective relationship for use 

within a temperature range of -45 °C to 60 °C is provided by the Mangus formula with 

coefficients adjusted by Sonntag [1]. 

𝑃𝑊𝑆 = 𝛼 ∙ 𝑒
(

𝛽∙𝑇
𝑇+𝜆

)
 

Where, 𝛼  = 4.584 Torr, 𝛽 = 17.62 and λ = 243.12 °C 

Combining the equations shown above yields the final relationship for converting the wet 

and dry definitions of concentration to relative humidity. 

 

For example, a wet concentration of 1.5% H20 at 18.0 °C and 760.0 Torr yields a 

relative humidity of 73.8%. 

A dry concentration of 1.5% at 18.0 °C and 760.0 Torr yields a relative humidity of 

72.7%. 

[1] Sonntag D.: Important New Values of Physical Constants of 1986, Vapour Pressure Formulations based 

on the ITS-90 and Psychrometer Formulae; Z. Meteorol.70 (1990) 5, 340-344 

𝑅𝐻 = 𝐶𝑤𝑒𝑡 ∙
𝑃

𝛼
∙ 𝑒

−(
𝛽∙𝑇
𝑇+𝜆

)
=  

100 ∙ 𝐶𝑑𝑟𝑦

(𝐶𝑑𝑟𝑦 + 100)
∙

𝑃

𝛼
∙ 𝑒

−(
𝛽∙𝑇
𝑇+𝜆

)
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Introduction to CRDS 
Technology 

Picarro analyzers use time-based, optical absorption spectroscopy of the target 

gases to determine concentration in a sample. They are based on wavelength-

scanned cavity ring-down spectroscopy (WS-CRDS), a technology in which light 

travels many times through the sample, creating a very long effective path length 

for the light to interact with the target gas, thus enabling excellent detection 

sensitivity in a compact and rugged instrument.  

The Picarro analyzer is comprised of two modules: 

• The Analyzer contains the spectrometer, sample chamber, and a computer 

with a hard drive to store and analyze data. The single analyzer module 

controls the operation of the system and converts spectroscopic 

measurements into gas concentration data. 

• The External Vacuum Pump draws the sample gas through the instrument. 

E.1 Cavity Ring-Down Spectroscopy (CRDS) 

Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 

isotopologue (e.g., H2
18O, 13CO2, 15N14N16O) uniquely absorb specific 

wavelengths of near-infrared light. The strength of the light absorption is 

related to the concentration of a molecule in a sample and the distance that 

light travels through the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to 

detect trace gases at levels in the part-per-million. Cavity Ring-Down 

Spectroscopy (CRDS), on the other hand, is one thousand to one million 

more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity 

and the time-based measurement. In the cavity, a series of mirrors reflects 

the infrared light through the sample, increasing the path length. For a 

Picarro cavity of only 25 cm in length, the effective path length of the cavity 

can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity 

where three mirrors reflect the laser light as seen in Figure 71. The light 

enters through the mirror closest to the laser, bounces off the angled mirror 

in the lower right corner of the cavity, travels to the hemispherical mirror at 

the top of the cavity, bounces toward the mirror in the lower left corner of 
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the cavity, and then returns to the first mirror. This motion becomes a 

continuous traveling light wave, which is represented by the dark orange 

path in Figure 71. 

 

Figure 71: Schematic of Picarro CRDS Analyzer Cavity 

When the laser is on, the cavity quickly fills with laser light. A small amount 

of the laser light is transmitted through the mirror closest to the 

photodetector, which turns the incident light into a signal that is directly 

proportional to the light intensity in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 

microseconds), the laser is turned off. The light contained within the cavity 

continues to bounce between the mirrors (about 40,000 times). Since the 

mirrors have slightly less than 100% reflectivity (99.999%), the light inside 

the cavity steadily leaks out of the cavity. The intensity of the light reaching 

the detector decreases, falling exponentially until it reaches zero. This 

decay, or “ring-down,” is measured in real time by the photodetector. 
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E.2 Relating Ring-Down Time to Absorption Intensity 

The time it takes to ring-down is inversely related to the total optical loss in 

the cavity, including the strength of molecular absorption at a given 

wavelength of light. For an empty cavity, the time it takes for the intensity to 

decrease by a given percent is determined solely by the reflectivity of the 

mirrors. A cavity containing gas that absorbs light will have a shorter ring-

down time than an empty cavity. As the light circulates in a cavity with a 

gas sample, the molecular absorption by the gas results in a decrease of 

the light intensity. 

Determining absorption intensity at a specific wavelength requires 

comparing the ring-down time of an empty cavity to the ring-down time of a 

cavity that contains gas (Figure 72). A cavity can be empty if it contains no 

gas; it will also appear empty if the molecules of the sample inside the 

cavity do not interact with the specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by 

switching the light to wavelengths that are not absorbed by the target 

molecules. The analyzer subsequently measures ring-down times at 

wavelengths that are absorbed by the target gas. The analyzer 

automatically and continuously compares these two types of ring-down 

times, and the software uses those comparisons to calculate absorption 

intensities. 

 

Figure 72: Light Intensity as Function of Time in CRDS System 
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E.3 Converting Absorption Intensity to Concentration 

Plotting the absorbance at each measured wavelength generates an 

optical spectrum. This spectrum contains absorbance peaks that are 

unique to each molecule in the sample. The height of a particular 

absorption peak is proportional to the concentration of a molecule that 

generated the signal.  

The height of the peak is calculated by subtracting the maximal 

absorbance from the baseline absorbance. Figure 73 shows a plot of ideal 

optical spectra with a clean, uniform baseline on either side of the 

absorption peak. 

 

Figure 73: Absorption Spectral Curve 

However, optical spectra often contain several absorption lines, nested 

closely together. A particular absorption peak may be visible between lines, 

but the absorption may not return to the baseline before it rises in response 

to another molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak 

by modeling the absorption peaks from other surrounding molecules and 

subtracting contributions from neighboring peaks to the absorption 

intensity.  
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E.4 Spectral Precision and High Sensitivity 
Measurements 

Picarro analyzers contain two features that provide high spectral precision:  

• A proprietary wavelength monitor (WLM) that measures the 

absolute laser wavelength to a precision that is a few orders of 

magnitude narrower than the spectral linewidth: Picarro’s patented 

WLM measures absolute laser wavelength to a precision more than 

1,000 times narrower than the observed Doppler-broadened 

linewidth for small gas-phase molecules. The instruments lock the 

laser to the WLM, and then the monitor tunes to wavelengths known 

to be maximally and minimally absorbed by the target molecule. The 

result is closely clustered absorption intensities, measured at 

wavelengths just before peak absorption, at peak absorption, and 

just after peak absorption, as the absorbance returns to the 

baseline.  

• Precise temperature and pressure control in the sample cavity: 

Accurate absorption measurements at precisely known wavelengths 

account for little unless the temperature and pressure of the CRDS 

measurement cavity are known. The observed line intensity and 

shape depend on the temperature and pressure inside the sample 

cavity. Small temperature and pressure instabilities can result in 

large concentration errors due to fluctuating peak heights and 

baselines. To completely minimize instrument measurement drift, 

temperature and pressure must be actively stabilized to constant 

values.  

For precise temperature control, the sample cavity is surrounded by layers 

of thermally insulating material to provide a high degree of passive thermal 

stability. The cavity is further actively stabilized by means of a solid-state 

heating system locked to the output of a thermal sensor. This enables the 

temperature of the cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-

linearity pressure transducer. The system computer uses this pressure 

data in a feedback loop to control proportional valves that adjust the inlet 

and outlet gas flow of the cavity. 
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